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FOREWORD
Since its establishment in 1976, Acharya Nagarjuna University has been forging ahead

in the path of progress and dynamism, offering a variety of courses and research contributions .'
I am extremely happy that by gaining a B++ (80-85) grade from the NAAC in the year 2003,
the University has achieved recognition as one of the front rank universities in the country. At
present Acharya Nagarjuna University is offering educational opportunities at the UG, PG
levels apart from research degrees to students from about 300 affiliated colleges spread over
the three districts of Guntur, Krishna and Prakasam.

The University has also started the Centre for Distance Education with the aim to
bring higher education within reach ot all. The Centre will be a great help to those who cannot
join in colleges, those who cannot afford the exorbitant fees as regular students, and even
housewives desirous of pursuing higher studies. With the goal of bringing education to the
doorstep of all such people, Acharya Nagarjuna University has started offering B.A. and
B.Com courses at the Degree level and M.A., M.Com., M.Sc, M.B.A. and LL.M. courses at
the PG level from the academic year 2003-2004 onwards.

To facilitate easier understanding by students studying through the distance mode,
these self-instruction materials have been prepared by eminent and experienced teachers.
The lessons have been drafted with great care and expertise within the stipulated time by
these teachers. Constructive ideas and scholarly suggestions are welcome from students
and teachers involved respectively. Such ideas will be incorporated for the greater efficacy of
this distance mode of education. For clarification of doubts and feedback, weekly classes and
contact classes will be arranged at the UG and PG levels respectively.

It is my aim that students getting higher education through the Centre for Distance
Education should improve their qualification, have better employment opportunities and in
turn facilitate the country's progress. It is my fond desire that in the years to come, the Centre
for Distance Education will grow from strength to strength in the form of new courses and by
catering to larger number of people. My congratulations to all the Directors, Academic
coordinators, Editors and Lesson - writers of the Centre who have helped in these endeavours.

Prof. P. Rajasekhar
Vice - Chancellor,

Acharya Nagarjuna University



LESSON - 1

INTRODUCTION TO ACCESS
1.0 OBJECTIVE: After going through this lesson the student can know what is Ms-Access?
What is a Data base ? Parts of an Access window etc.

STRUCTURE:
1.1 Introduction
1.2 What is Access?
1.3 What are Data bases good for ?
1.4 Data base
1.5 Objects of Microsoft Access database
1.6 Parts of An Access Window.
1.7 Starting Microsoft Access
1.8 Exiting Access
1.9 Summary
1.10 Model Questions
1.11 Reference Books

1.1 INTRODUCTION :
When a business is small and simple we can keep track of the entire information with simple

lists on paper. However as the volume of business grows, the volume of data also grow, and then
we need a more efficient way of storing, processing and retrieving data.

I For example we start a small business and buy three products from three suppliers and sell
to about 25-30 customers. Things are simple. We know everybody by their first name and all the
information that you require is on your fingertips. As business grows we add many more products
from different suppliers to our catalogue. Automatically we sell to a large number of customers,
which are being handled by a dedicated marketing and sales team. Now we need to know, which
customer is buying what on a regular basis. The same item may be supplied by many suppliers, so
you need to know who is supplying at most competitive rates and in shortest time. We also need to
know which sales representative is booking maximum orders. All these needs prompt us to use
Access.

1.2 WHAT IS ACCESS?
Microsoft Access is a database management system. It may also be refered as database

program.
Access enables you to collect, store and arrange information as well as run reports that lead

to calculations. Here are a few of things that you can do with Access.
* Type data directly into a database or import it from another programme.



Centre for Distance Education 1.2 Acharya Nagarjuna University

* Sort, Index and Organize the way you want.

Quickly create reports and mailing labels, using all or part of your data.

Make customized data entry forms that simplify the way less experienced computer us
ers enter new information in the database.

Run queries that extract subsets of your data based on certain conditions.

*

*

*

1.3 WHAT ARE DATA BASES GOOD FOR?
Strictly speaking a database is any collection of information. Your local telephone book, for

example, is a data base, with a computerized database in Microsoft Access, you can store infor
mation. Not only storing information you can also do much more. For instance, if you keep a list of
all your business customers in an Access database, you can.

* Print a list of all customers who have not bought anything in the last 60 days, along with
their phone numbers, so you can call each one.

* Sort the customers by ZIP code and print out mailing labels in that order.

Create a simple on screen order entry form that even your most technically unskilled
employee can use successfully.

These examples only scratch the surface. With Access, you can manipulate your data in
almost any way you can dream up.

*

1.4 DATA BASE :

A systematic organization of data is called a data base. Traditionally, fields and records are
used to organize data bases. A record is all the information about one item. In a Rolodex file, for
instance, everything related to one person is on a single card, so the card is a record. A field is
category of information. Three fields in a Rolodex card would include the name, phone and ad
dress.

A flat-file database is a data base program that can only accommodate databases consisting
of a single table. A program such as Access is called a relational data base because it can create
two or more tables that are linked together.

1.5 OBJECTS OF MICROSOFT ACCESS DATABASE:
There are seven objects of Microsoft Access database. All these objects for a given data

base are saved in a single Access database file with an extention name ".mdb". These objects are:
1.Tables:

A Table is a fundamental building block of an Access database. All databases must have
atleast one table because this is where the data is stored. Tables are grids of rows and columns.
Each column in a table is called a field. Each field contains a specific type of information such as
first name, last name, phone number, e-mail, date of joining etc. Each row of many columns con
tains information about one specific item, person or transaction.
2. Query:

A Query is a filter through which data is evaluated. You can define a filter criteria in a query
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and only those record which meet this criteria are displayed. There are three types of queries. :
a. The most common type of query is a select query which displays a subset of the entire

data, sorted and selected using the criteria you specified. Examples of a simple query
could be a list of all customers from India only, a list of only those employees whose last
name is 'Jain'. You can build very complex queries using combinations of many different
criteria.

b. Action Queries: These queries create new tables or delete, append and update records
in existing tables.

c. Cross Tab Queries: These queries display spread sheet like cross tabular result forms.

3. Forms:
Forms are used to simplify data entry work or to display information in a specific manner.

Forms let you add, modify and delete database data. In Access you can create six different types of
forms.

Data Sheet
Main I Subform

Chart
Pivot Table Form

Purpose.
Fields arranged as column
Displays data in row and column format similar to a
data sheet.
Identical to table datasheet
Displays both main and related table data.

Displays information with a graph.
Creates a Pivot Table Form similar to an Excel Pivot
Table Report.

Types of Forms.
Columnar

Tabular

4. Reports:
A Report summarizes data in a format suitable for publishing i.e to view data on the screen or

to print it on a printer or to publish it on the web. Reports are used to present data in a meaningful
and attractive manner and here you can combine data, charts and images, even audio and video.
There are six ways to create reports in Access.

Chart wizard

Purpose
Begins with a blank page. You layout the report the way you'
want using the design tools in the tool box.
Choice of fields, sort criteria and report layout used creates
tabular or columnar report.
One or more records displayed vertically. Selected from a
single table or query.
Rows and columns grouped by field values. Selected from a
single table or query.
Leads you through creation of a report containing a chart and

Reports
Design view

Report wizard

Columnar Auto Report

Tabular Auto Report
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associated data.

Label wizard Helps you create mailing lables from data.

5. Data Access Page: A DataAccess Page is a web HTML page created inAccess that allows
users to view, add or edit data stored in an Access data base. Using Data Access Pages you can
easily create interactive forms for users on a website. Unlike other Microsoft Access objects, Data
Access Pages are stored outside the Access database file, which allows you to send them through
e-mail or display them on the web.

By using Data Access Pages, users who do not have Microsoft Access installed on their
computer can still' share and use data contained in a Microsoft Access database or MS Sequel
server data base.

6. MACROS :A Macro is used to automate repetitive tasks. Basically any operation that you do
over and over again can be automated by creating a macro, so that at a click of a button or by
pressing a particular key an entire sequence of commands can be executed. Macros are often
attached to buttons that appear on forms, to make data entry work. You can create a set of buttons
each linked to a separate macro which generates a specific report.

7. MODULES: For most of your simple repetitive tasks you can create macros and simply your
work. However if you want to develop a full fledged software application which automates a wide
variety of complex tasks, you should create of Visual Basic for Application module. For larger and
complex projects VBA gives you considerable flexibility, control, power and ease of maintenance
that is just not possible by writing simple macros. You can attach VBA modules to any form or
report that you require.

1.6 PARTS OF AN ACCESS WINDOW :
An active window has:
See the figure 1.1 : parts of an Access
window.

Tool Bar: This tells you which application
package is currently running andwhich slide
is currently open.

Menu Bar : This is the traditional windows
style drop down menu. When you point to
any menu title and click once with the
mouse, the menu will open, displaying all
the commands available under this menu
title. Alternatively, this menu can also be
activated by presslnq the access keys from
the key board e.g. Press Alt + F to activate
the File menu. You will notice that the ac
cess key for each menu option is under- r:-:-:--+-:-...,.,--.."

lined, e.g. Alt +E for Edit menu, Alt +1 for ~~~
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Insert menu and so on. Once a roll down menu has been activated, clicking on the desired com
mand would tell Access to execute that command. Some commands have ellipses (...) in front of
them. These commands have further sub commands. Commands appearing dimmed cannot be
executed unless the pre-requisite functions required by that command have been performed, e.g :
you cannot use the copy or cut command from the Edit menu unless you have selected a piece of
text first. Many commands also have a keyboard shortcut specified against their names

STANDARD TOOL BAR:
Toolbars contain buttons, dropdown menus and other controls that help you quickly alter the

appearance and arrangement of documents by executing a variety of Access commands. Toolbars
are very helpful and convenient in quickly executing commands without having to go through menus.
The standard toolbar contains icons for basic functions like opening new files, printing files, send
ing and receiving emails, address book etc.
MAIN SWITCH BOARD :When you open an Access database, you often see a screen labelled
Main Switch board that provides buttons to enable you to use the data base easily.

1.7 STARTING MICROSOFT ACCESS
See the above figure 1.2 :

A. Click on Microsoft Access button form the Microsoft shortcut bar OR

B. Alternatively choose Microsoft Access command from Microsoft office option from pro
grams options from start menu

1.8 EXITING ACCESS :
When you finish working with Access, you should exit it to free up your computer's memory

for other tasks. You can exit Access in several ways :

* Press Alt +F4
* Select File, Exit

,
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* Click the Access window's close (X) button.

1.9 SUMMARY :
In this lesson, you learned how to start and exit Access, and about the main parts of the

screen, including the toolbar buttons.

1.10 MODEL QUESTIONS
1. Explain Access

2. What is Data Base

3. Explain the objects of Microsoft Access.

4. Explain the procedure of starting Microsoft Access.

5. How can you use Micro Soft Access for Data Base.

1.11 REFERENCE BOOKS :
1. Ron Mansfied

2. Guy Hart Davis
- Working with Ms Office - Tata Mc Graw Hill 2000.
- The ABC's of Microsoft office - B.P.B Publications, New

Delhi.
3. Ms Office 2000 Complete - BPB Publications, New Delhi.
4. Faithe Wempen - Access 97 - PHI Private Limited, New

Delhi.

Dr. Ch. Suravinda

1



LESSON - 2

CREATING A SIMPLE DATABASE
2.0 OBJECTIVE: In this lesson, you will learn how to create a blank data base. You also will
learn how to create a database with pre-made tables, reports and forms with the database wizard.

STRUCTURE :-
2.1 Introduction
2.2 Creating a Blank Database
2.3 Creating a Database through Table Wizard

2.4 Summary
2.5 Model Questions
2.6 Reference Books.

2.1 INTRODUCTION :
A well-designed data base ensures convenient and fast access to the information that you

want. While planning for creating a new data base, keep the following points in mind.
1. Define the purpose of your database consider the present and future queries you may

want to answer from the stored data.
Example: If you want to run a query on a customer's database, to generate state wise,
city wise lists create two separate fields for city and state instead of one address field.

2. Determine the tables that you do or may need in future in the database. Each table
contains information only about one subject like customers, suppliers or items.

3. Determine the fields that you need in each table. Each field contains a specific kind of
information such as first name, last name or accounts balance.

4. Identify unique field values that allows Access to relate and store information contained
in different tables. These unique fields are also called the primary key for the table.

Example: Two tables containing employees background information and his current
month's salary details may be lined using a primary field called employee code.

2.2 CREATING A BLANK DATABASE :
Creating a blank database is very simple because you are

just creating an outer shell at this point without any tables, forms. If
you just started Access and the Microsoft Access dialog box is still
displayed.

See the figure 2.1 (Microsoft Access dialog box).

Follow these steps
1. Click Blank Access database radio button.

, •
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2. Click OK to continue.

You would now be asked to give a name for your Access database.

3. Click in the save in box and choose the folder where you want to save your file in.

4. Give the name of the database in this box.

5. Click on create button to create a new database.

The following window would be displayed. This window is commonly known as the
Main switch board. It provides buttons to enable you to use the database easily.

6. Click on the Table tab to create a new table.

7. Double click on the 'Create Table by using Wizard' to create a table using the table
wizard.

See the below figure 2.2 :

See the below figure 2.3 :

..
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See the figure 2.4

2.3 CREATING A DATABASE THROUGH TABLE WIZARD :
Creating the tables through the table wizard is much more faster and easier than through the

design mode. However if you use wizards you are somewhat restricted with the predefined set
tings already available.

1. Click on the Business radio button.
2. Choose Employees from the sample Tables by clicking on it.

ToAdd fields into the table click on fields in the sample fields. Then click on ">' button to
add the fields in the 'fields in my new table' category. If you want to take all the fields
from the sample fields category to your new table then click on the "»~'button. Similarly
if you want to remove a field click on '<' button.

3. Click on Next button to continue.

4. Click on this box and
give the name of
your table.

5. Click on this radio
button to let Access
set the primary key
for database.

6. Click on Next button
to continue.

See the figure 2.5 :

,
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See the figure 2.6 :

The Followingwindowwouldbe displayed
7. Clickon this radiobutton.
8. Clickon Finishbutton;

See the figure 2.7 :
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Since earlier we had choosen an option to enter the data directly in the table therefore
this table has been shown. You can now start entering the data directly in the table.

See the figure 2.8
After entering the data your table would look some what like this

See the figure 2.9.

•
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9. Click on close button to close the Employees table.

10. Click on yes button to save the changes made to your table.

See the figure 2.10.

2.4 SUMMARY :
A database can be created from scratch and then manually create a" the tables, reports and

forms or use a database wizard, which does a" that you wi" need. Access comes with several data
base wizards. These are mini-programs that interview you about your needs and then create a
database structure that matches them.

2.5 MODEL QUESTIONS:
1. What are the points which should be bear in mind while preparing a new database?
2. Explain the procedure of creating a Blank DataBase.
3. How can you create a Database through Table Wizard.

2.6 REFERENCE BOOKS :
1. Ron Mansfied

2. Guy Hart Davis

- Working with Ms Office - Tata Mc Graw Hi" 2000.

- The ABC's of Microsoft office - B.P.B Publications, New
Delhi.

3. Ms Office 2000 Complete - BPB Publications, New Delhi.

4. Faithe Wempen - Access 97 - PHI Private Limited, New
Delhi.

Dr. Ch. Suravinda

t J



LESSON· 3
CREATING TABLES

3.0 OBJECTIVE :
After going through this lesson the student can know how to create a new Table by different

methods.

STRUCTURE:
3.1 Introduction
3.2 Creating a New Table
3.3 Relationships
3.4 Creating Table through Design View
3.5 DataTypes and Formats
3.6 Setting the Primary Key
3.7 Creating a Table with the Table Wizard
3.8 Summary
3.9 Model Questions
3.10 Reference Books

3.1 INTRODUCTION :
Tables are the basis for the whole database. Tables hold your data; everything else in just

dress up. When you create a table, you can create it ''from scratch" or you can use the Table
Wizard. This lesson covers both the methods.

3.2 CREATING A NEW TABLE :
We will now see how to cre

ate a new table by a different
method.

1. Double click on 'create
table by entering data' to create
another table.

See the Fig. 3.1

•,,
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The following table would be displayed you can now start entering data into it.
See the Fig. 3.2

As you noticed that the columns names are named as Field 1, Field 2 and so on. To make
things more simpler and easier to understand we will now rename the columns.

Choosing Rename column command from Format menu to rename the column heading.
You could also double click on the columns heading to change the heading.

Your cursor would be placed on
the column heading and you can type
the heading that you want.

See the Fig. 3.3

•
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SAVING THE DATABASE :
1
After having finished entering the data, you must save it, so that in case of any electrical

disturbfancesall your precious work is not lost.
1. Choose save command from file menu.

The following dialog box would be displayed. Fig. 3.4 Pg No. A.17 (fig 2)

2. Give the name of the new table in this box
3. Click on OK button to save the table.

Thefollowing message box would be displayed. Since you have not defined a
primary key it is now asking you to so.

,~. Click on yes button the define a primary key for your database.
~. You could still enter records in this database or close it now. Click on this close

button to close this database.

3.3 RELATIONSHIPS :
A relationship works by matching the data in two different tables using a common primary

field. There are broadly two kinds of relationships - one to one and one to many. In a one to one
relatiqnship for one record in table A there is only corresponding record in table B, where as in one
to mary relationships for each record in table A there are many records in table B.

f'Jow to link the two tables i.e., the Employee table with the salary table.

11. Choose Relationships command from Tools menu.

!See the Fig. 3.4

2. Click on the
Employee code field in the employee table. Keep your mouse pressed and drag
your mouse pointer on top of the 10field in the salary table. Now leave your mouse.
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See the Fig. 3.5

The Following dialog box would be displayed.
See the Fig. 3.6

3. Click on create button to create the relationship between the two tables.
As you can see here that the tables are now linked together.

4. Click on the close button to close the dialog box.
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3.4 CREATING A TABLE IN TABLE DESIGN VIEW :
If you want to create a table that contains special fields not available in a wizard, you are

better off creating that table in TableDesignview.
Nowyou will see how to create a table in TableDesignView.

To crate a table in TableDesignview, Followthese steps :
1. In the Database window, double-click create table in Design view. From this Table

Design view, you can control the entire table creation process.

See the Fig. 3.7

OTHER METHOD:
Instead of Step 1, you can choose Insert, Table, or click the New button in the
database window to open the New Table Dialog Box. Then click Design View and
then OK.

2. Type a Field name on the first employ line of the Field Name column. Then press
Tab to move to the Data Type column.

3. When you move to the Data Type column, an arrow appears to a drop-down list
there. Open the Data Type drop-down list and select a field type. If you donnot
make a choice, the field will be a text field by default.
Field Naming Rules: Field names inAccess can be up to 64 characters long and
can contain spaces if you like and any symbols except periods (.), Exclamation
marks (!), accent grave symbols ('), or square brackets ( [1 ). You might want to
stick with short, easy-to-remember names, however it is also advisable to avoid
punctuation marks such as $,% or # in field names, because some of them have
special meanings in Access Code.
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4. Press Tab to move to the Description column, and type a description of the field. (
This is optional, the table will work fine without it).

See the Fig. 3.8

5. In the bottom half of the dialog box, you see Field properties for the field type you
selected (fig. 3.8). Make any changes to them that you want.

6. If you have more fields to enter, repeat step 2 to 5.
7. Click the Table Design window's close (x) button.

8. When you are asked if you want to save your changes to the table, click yes. The
Save As dialog box appears.

9. Type a name for the table in the Table Name text box and then click OK.

3.5 DATA TYPES AND FORMATS :

Each field must have a type, so Access will know how to handle its contents. Here are the
types you can choose from :

Text Plain, ordinary typing, which can include numbers,
letters and symbols. A Text Field can contain up to
255 characters.

Meno More plain, ordinary text, except you don't set a
maximum field length, so you can type an almost
infinite amount of text (64,000 characters).

A plain, ordinary number (not currency or a date).
Access won't allow any text.

Simply a date or a time .

Number

Date I Time

...
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Currency A number formatted as an amount of money

Auto Number Access automatically fills in a consecutive number
for each record.

The answer to a true I false question. It can contain
one of tax values. Yes or No. True or False, On or
Off.

Yes I No

OLE Object A link to another database or file. This is an ad
vanced feature.

Hyperlink

Lookup Wizard

A link to a location on the web.

Lets you create a list to choose a value from an
other table or list of values in a combo box for each
record. It is an advanced feature.

In addition to a field type each field has formatting
options you can set. They appear in the bottom half
of the dialog box, in the field properties area. The
formatting options change depending on the field
type; there are too many to list here, but following
are some of the most important ones you will en
counter.

Required

The maximum number of characters a user can
input in that field (applies only to Text Fields).

A Drop-down list of the available formats for that
field type.

For number fields, you can set the default number
of decimal places a number will show.

If a field is usually going to contain a certain value
you can enter it here to save time. It will always
appear in a new record, and you can type over it in
the rare instances when it doesnot apply.

Choose Yes or No to tell Access whether a user
should be allowed to leave this field blank when
entering a new record.

Field Size

Format

Decimal Places

Default Value

3.6 SETTING THE PRIMARY KEY
Almost every table should have at least one field that has a unique value for each record. For

instance, in a table of the dogs your kennel owns, You might assign an 10number to each dog, and
have an 10# field in your table. This unique identifier field is known as the primary key field.

You must tell Access which field you are going to use as the primary key. So it can prevent
you from accidentally entering the same value for mor e than one record in that field. To set a
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primary key, follow these steps :

1. In Table Design View, select the field that you want for the primary key.

2. Select Edit, Primary Key or Click the primary key button on the toolbar. A key
symbol appears to the left of the field name, as show in Fig. 3.3

See the Fig. 3.9

3.7 CREATINGA TABLE WITH THE TABLE WIZARD:
As you have already seen you can create a table ''from scratch" or you can use the Table

Wizard.

The table wizard can save you lots of time by creating and formatting all the right fields for a
certain purpose. Access comes with dozens of premade business and personal tables from which
to choose. You can pick and choose among all the fields in all the pre-made tables, constructing a
table that's right for your needs. Even if you can't find all the fields you need in pre-made tables, you
might want to use the Table-wizard to save time, and then add the missing fields later.

If the fields you want to create are similar to any of Access's dozens of pre-made ones, The
Table Wizard can save you a lot of time and effort with the Table Wizard, you can copy fields from
any of the dozens of sample tables.

To create a table using the Table Wizard, follow these steps:

1. In the database window, click the Table object and then double click create table
by using wizard.
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2. On the first Table Wizard dialog box (see Fig. 3.4) click either Business or Per
sonal. This determines the list of sample tables that will appear.

3. choose a table from the sample Tables list; its fields appear in the sample Fields
list.

4. Look at the sample fields list, if you see a field that you want to include in your new
table, select it and then click the> button to move it to the Fields in my new table
list. To move the entire contents of the selected sample table to your list, click the
»button.

See the Fig. 3.10

5. Repeat steps 3 and 4 to select more fields from more sample tables until the list
of fields in you new table is complete. You can remove a field from the list by
clicking the <button. When you are finished adding fields. Click Next to continue.

6. You are asked for a name for the table Type a more descriptive name to replace
the default one.

7. Click yes, set a primary key for me to have the wizard choose your primary key
field, or No, I will set the primary key to do it yourself. (If you choose Yes, skip to
step 10).

8. The Wizard next asks which field will be the primary key (see fig. 3.5). Open the
drop-down list and select the field.

See the Fig. 3.11
9. Choose a data type for the primary key

field:
Consecutive numbers Microsoft Access
assigns automatically to new records
choose this if your primary key field is a
simple record number-that is, if you want
Access to number the records you enter
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consecutively as you enter them. Numbers 1 enter when I add new records pick
this to enter your own numbers. This choice works well for unique 10numbers such
as driver's licenses Numbers and or letters I enter when I add new records. Pick
this if you want to include both numbers and letters in the field. For instance, if your
primary key field is a vehicle identification number for the cars in your fleet, you will
need to enter both numbers and letters.

10. Click Next to continue

11. If you already have at least one table in this database, a screen appears offering
to create relationships between tables. Just click Next to move past it.

12. At the finish screen, click one of the following options:

1. Modify the table design. This takes you into Table Design view, the same as if
you had created all those field yourself choose this if you have some changes you
want to make to the table before you use it.

Enter data directly into the table. This takes you to Table Datasheet view. Where
you can enter records into the rows of the table. Choose this if the tables design
seems perfect to you as is. Enter data into the table using a form the wizard cre
ates for me.

13. Click Finish to move where you indicated you wanted to go in step 12.

If you decide you don't want to work with this table anymore right now, just click the
close ( x ) button for the window that appears.

Now you have a table. In the database window, when you click the Tables tab, you can see
your table on the list.

3.8 SUMMARY :

Table are the basis for the whole database. When you create a table, you can create it ''from
scratch" or you can use the Table Wizard. The Table wizard can save you lots of time by creating
and formatting all the right fields for a certain purpose. If you want to create a table that contains
special fields not available in a wizard, you are better off creating that table in Table Design View.

3.9 MODEL QUESTIONS :
1. Write down the methods of creating a new table.
2. Explain Relationships

3. Explain Data types and formats in Access.
4. How can you create a table through Design View?
5. Explain the steps of crating a Table with the Table Wizard.
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LESSON - 4

FORMS FOR DATA BASE
4.0 OBJECTIVE:

After going through this lesson the student can know what is Form ? The importance of
Forms in a database and their creation.

STRUCTURE:
4.1 Introduction
4.2 The Purpose of Forms in a Data Base
4.3 Methods of Creating a Form
4.4 The Auto Form Wizard
4.5 Making a Form with the General Form Wizard
4.6 Creating a Form from Scratch
4.7 Adding Controls to a Form
4.8 Modifying a Form
4.9 Creating Special Data Entry Fields on a Form
4.10 Creating a List Box or Combo Box
4.11 Creating An Option Group
4.12 Adding Command Buttons
4.13 Inserting Active X Controls
4.14 Summary
4.15 Model Questions
4.16 Reference Books

4.1 INTRODUCTION :
All the data you enter into your database ends up in a table for storage. You can enter informa

tion directly into a table, but is is a little bit awkward to do so. Most people find it easier to create a
special onscreen form in which to enter the data. A form resembles a fill-in-the-blanks sheet that
you would complete by hand, such as a job application.

Access links the form to the table and stores the information that you put into the form in the
table.

Forms are data-entry tools. You can arrange fields from several tables on a form and easily
enter data into those fields on a single screen.

4.2 THE PURPOSE OF FORMS IN A DATABASE :
Developers use forms for data entry, editing and viewing. The two reasons for using forms in
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your database application are

1. Form can increase people's comfort level with a computer application.

2. Forms have facilities for data filtering, automation and validation beyond that possible
using tables or queries alone.

4.3 METHODS OF CREATING A FORM
There are three ways to create a form :

1. Auto Forms provide very quick, generic forms that contain all the fields in a single table.
2. The Form Wizard helps you create a form by following a series of dialog boxes and

choosing the fields ~nd style for the form.
3. Creating a form from scratch.

4.4 THE AUTO FORM WIZARD :

The easiest way to create a form is with Auto Form. Auto Form simply plunks the fields from
a single table into a form; it is the least flexible way but is is very convenient. The steps are

1. From the Database window, click the Forms object type.
2. Click the New button. The New Form dialog box appears

See Fig. 4.1

3. Click Auto Form : columnar to create a columnar form. This creates a form that con
tains your fields in a single column form top to bottom or click Auto Form; Tabular for a
form that resembles a table, or Auto Form: Data sheet for a form that resembles a
datasheet.

4. Open the drop down list at the bottom of the dialog box and choose.the table or query to
use as the source of the form's data.

5. Click OK. The form appears, ready for data entry.

The form you get with an Auto Form might not be very pretty. The field labels might be cut off,
and the fields might be too close together to be attractive. If the form created by Autoform is not
what you want, delete it and try again with the Form Wizard. To delete the form, close it and answer
'NO' when asked if you want to save your changes.
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4.5 MAKING A FORM WITH THE GENERAL FORM WIZARD :

Forms For Data Base

The Form Wizard offers a good compromise between the automation of Auto Form and the
control of creating a form from scratch. Follow these steps to use the Form Wizard :

1. From the Database window, click the Forms object type.
2. Double-click create form by using wizard. The form Wizard opens the following win

dow.

See the Fig. 4.2

3. From the Tables I Queries drop-down list, choose a table or query from which to select
fields.

4. Click a field in the Available Fields list that you want to include on the form, and then
click the> button to move it to the selected Fields list.

5. Repeat step 4 until you have selected all the fields you want to include from that table.
If you want to include from that table. If you want to include fields from another table or
query, go back to step 3 and choose another table.

6. Click Next to continue, you are asked to choose a layout; columnar, Tabular, Datasheet,
or justified. Click each button to see a preview of that type. Then click the one you want
and click Next.

7. Youare asked to choose a style. Click
each style listed to see a preview of
it; Click Next when you have choosen
the one you want.

8. Enter a title for the form in the text
box at the top of the dialog box.

9. Click the Finish button, The form ap
pears, ready for data entry.
See the Fig. 4.3
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If your form's field labels are cut off, like the ones in fig. 4.3, you should edit the form to move
the fields over so there is more room. You learn how to move fields around to improve the look in
later part of the lesson.

4.6 CREATING A FORM FROM SCRATCH :
The most powerful and difficult way to create a form is with Form Design View. In this view,

you decide exactly where to place each field and how to format it. The following steps introduce you
to Form Design View:

1. From the Data base window, click the Forms object type.
2. Click the New button. The New Form dialog box appears.
3. Click Design View

4. Select a table or query from the drop-down list at the bottom of the dialog box. You can
change the table later on, if you need to, from the Record source property in the form's
properties sheet.

5. Click OK. A Form Design Window appears. You are ready to create your form

In the next lesson, you'Uleam to
create other besides Detail.

See the Fig. 4.4
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4.7 ADDING CONTROLS TO A FORM
The basic idea of the Form Design Window is simple. It is similar to a light table or paste-up

board where you place the elements of your Form. The fields you add to a form will appear as
controls in the form's Detail area. The Detail area is the only area visible at first.

To add a control displaying a field to the form, follow these steps:
1. Display the Field list if it is not showing. Click the Field List button or choose Field list

from the view menu to do so.
2. Drag a field from the Field list into the Detail area of the form, where it will appear as a

text box control.
3. Repeat step 2 to add as many fields as you like to the form.

See the Fig. 4.5

When you dl1g a field to a form the Field List, it becomes a control that displays data from
that field. You can cragmore than one field to the form at once. In step 2, rather than click and drag
a single field, do ore of the following before dragging:

1. To seled a block of fields, click the first one you want and hold down shift while you click
the last me.

2. To selec non-adjacent fields, hold down CTRL as you click each one you want.
3. To selec all the fields on the list, double click the Field List title bar.

You can move ibjects around on a form after you initially place them: If you are satisfied with
your form, go ahead and close it by clicking its close ( x ) button. When asked if you want to save
your changes, choos: yes. Type a name for the form in the text box provided, and then click OK. If
on the other hand, yOJwant to make more modifications to your form, leave it open.

'-",
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4.8 MODIFYING A FORM :
The form you have onscreen now might be functional, but it is probably not attractive. Here is

an overview picture of what you need to do to make a more attractive Form :
1. Move the controls as needed to create more space between them.
2. Adjust the spacing between each control and its label.
3. Resize any controls or labels needed so they are not truncated.
4. Add any explanatory text needed.
5. Add form headers and footers if needed.
6. Add text formatting to the text on your form.

4.8.1 MOVING CONTROLS :
The most common change to a form is to move a control around. You might want to move

several controls down so you can insert a new control or you might want to just rearrange how the
controls appear. Follow these steps :

1. If you are not already in Form Design view, enter it, as you learned previously.
2. Click a control's name to select it. Selection handles appear around it. You can select

several controls by holding down shift as you click each one.
3. Position the mouse pointer so the pointer becomes a hand. If you are moving more

than one control, you can position the mouse pointer on any selected control.
To move a control first select it. Then drag it when the mouse pointer is a hand shape.

4. Click and hold down the left mouse button as you drag the control to a different location.
5. Release the mouse button when the control is at the desired new location. You can

stretch a control vertically or horizontally from any side, or diagonallyfrom any corner.

You can move many controls at once, maintaining their relative positions by selecting all the
controls first and then dragging. To select multiple controls, click each one you ~nt while holding
down the CTRL key, or use the mouse to drag an outline around all the controls }f:>uwant to select.

,
4.8.2 MOVING CONTROLS AND THEIR LABELS INDEPEIDENTLY :

Sometimes you might need to move a text box control or a field label in~pendently of the
other. For ex : you might want to make a field's label box longer, so that the fieldhame displayed in
its caption does not appear cut off. But to do that, you must first move the texfbox control to the
right, to make room for a longer label. To move a text box or its attached label b~itself, follow these
~~: f

1. Click the control that you want to move.
,

2. Position the mouse pointer over the selection handle at the top le1lso that it becomes
a pointinq finger.

3. Drag the control to a new position.

To delet a label, select the label and press Delete.
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4.8.3 RESIZING CONTROLS
After you adjust the spacing between each text box and its label as needed follow the below

steps to change a controls length :
1. Click the control to select it. Selection handles appear around it.
2. Position the mouse pointer at the right edge, so the pointer turns into a double-headed

arrow.
3. Drag the control to its new length, and then release the mouse button.

4.8.4 VIEWING HEADERS AND FOOTERS :
Form Header and Form Footer is a place for text that should be repeated at the top or bottom

of the form, such as a form title at the top or a copyright notice at the bottom.

Page Header and Page Footers are rarely used. It is a place for text that should be repeated
at the top or bottom of every page of the form when you print the form. These are not displayed by
default; to display bars for them.

When you create a form with the Form Wizard, the Form header and Form Footer bars
appear in Design View, but there is nothing in them. And the Form Header bar is bulleted up against
the Detail bag, so the header area has no height.

To make some room to work in the Form Header, click the Form header bar to select it,
position the mouse pointer between the bars and drag down.

The otteil section contains
cootrolswhose data

changes with every record.

See he Fig. 4.6
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After you display a header or footer, you can add controls to these sections.

4.8.5 ADDING LABELS :

The next thing that most people want to do is add text to the form, in the form of label controls
to diplay titles, subtitles, explanatory text and so on. Add titles and other general information to a
header or footer; add information specific to particular controls to the Detail area.

Follow these steps :

1. If the Toolbox is not displayed, choose Toolbox from the view menu or click the Tool box
button on the toolbar.

2. Click the label tool in the tool box (the one with the italicized letters Aa on it). The mouse
pointer changes to a capital A with a plus sign next to it.
See the Fig. 4.7

3. Click any where on the form where you want to create the new text. A. tiny box appears.
(The box expands to hold the text as you type).

4. Type the text

5. Click anywhere out side the control's area to finish or press Enter.

4.8.6 FORMATTING CONTNROLS :

After you place all your information on the Form i.e., the controls you rant to include and
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labels to display any titles or explanatory text, the next step is to make the form look more appeal
ing.

All the formatting tools you need are on the Formatting toolbar (the second toolbar from the
top in Form Design View). Table 4.1 shows the tools. To format a control, just select it, and then
click tt'le appropriate formatting tool to apply the format to the control.

Table 4.1

tists the available fonts

tists the available sizes fot the
selected font

'lbggles. Bold oDJoff

••
II
II
II
!!
II••C2

Toggle$U~ onJoff

FiUs the selected box with the
selected color
Colors the teXtin the selected box

Colors the outIine.o(" selected
box
Adds a border to the selected box

Adds a special effect to the
selected box

Some tools, ke the font and size tools are drop-down lists. You click the down arrow next to
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the tool and then select from the list. Other tools are simple toggle buttons for turning bold and italic
on or off. Still other tools, such as the coloring and border tools, combine a button and a dropdown
list. If you click the button, it applies the current value. You can click the down arrow next to the
button to change the value.

you can change the color of the form background too. Just click the header for the section
you want to change to select the entire section. Then right click and choose Fill I Back color to
change the background color. If you do not like the formatting after you apply it, press CTRL + Z to
undo.

4.8.7 CHANGING TAB ORDER:
When you enter data on a form, you press Tab to move from control to control in the order

they are shown in the form. The progression form control to control is the tab order. When you first
create a form, the tab order runs from top to bottom.

When you move and rearrange controls, the tab order does not change automatically. For
instance, if you had 10 controls arranged in a column and you rearranged them so that the 10th one
was at the beginning, the tab order would still show that control in 10th position, even though it is
now at the top of the form. This makes it more difficult to fill in the form, so you will want to adjust the
tab order to reflect the new structure of the form.

Follow these steps to adjust the tab order :

1. Choose View, Tab order, or right-click the square in the form's upper-left corner and
select Tab order from the shortcut menu. The Tab order dialog box apoears.

2. Choose the section for which you want to set tab order. The default is Detail.
3. The controls appear in their current tab order. To change the order, clbk a control and

then drag it up or down in the list.

4. To Quickly set the tab order based on the control's current positions il the form (top to
bottom), click the Auto order button.

5. Click OK.

4.9 CREATING SPECIAL DATA ENTRY FIELDS ON A FORUI
Access special data-entry controls on a form provide the following :

1. It make your form look more professional.
2. They decrease the amount of typing you have to do when entering ecords,
3. They decrease the possibility of typing errors, making for more relicble '""'::Ita.

You can use several controls to make the form much more attractive and easyto use they are :

List Box

Combo Group
Presents a list from which you chooe an item.

Like a list box, but you can type in oher entries besides
those on the list.

Option Group Gives you options to choose from Ibut you can select

,
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only one). You can use option buttons, toggle buttons, or
check boxes.

Performs some function when you click it, such as start
ing another program, printing a report, saving the record,
or anything else you specify.

In Access 2000, you can place Active X controls or any
other kind of control or object on a form. For example,
you can include a video clip for each record.

Access comes with a wizard for most of these control types, which makes it easy for you to use the
controls.

Command Button

Other Controls

4.10 CREATING A LIST BOX OR COMBO BOX:
A list box:or combo box can come in handy if you find yourself typing certain values repeatedly

into a field. Fer example, if you have to enter the name of one of your 12 branch offices each time
you use a form, you might find it easier to create a list box containing the branch office names and
there you can click to select from the list. With a list box, the person doing the data entry is limited
to the pretyped choices that display.

A combe box is·useful when a list box is appropriate, but it is possible that a different entry
might occassimally be needed. For example, if most of your customers come from one of six
states but occessionally you get a new customer from another state, you might use a combo box.
During data enry, you could choose the state from the list when appropriate and type a new state
when it ~ not.

Follow these stepsto create a list box or combo box from Form Design View :
1. Male sure that the control wizards button in the toolbox is selected.
2. Clict the list box or combo box button in the toolbox. The mouse pointer changes to

shov the type of box you selected.
3. Dra~your mouse to draw a box on the grid where you want the new control to be.

Whel you release the mouse button, the wizard starts.
4. In thewizard's first dialog box click the button labelled Iwill type in the values that Iwant.

Thenclick Next.
5. You ee asked to type in the values that you want to appear in the list. Type them in

comb box, pressing the Tab key after each one. Then click Next.
6. Selec store that value in this field and choose which field should receive the data. For

exarnte, If you are entering the various titles a dog can earn in dog shows, select title
field hIre and click Next.

7. Type tie title that you want to appear for the control (that is, the text of its attached
label).

8. Click nish. Your new list box appears, bound to the field that you choose in step 6 in
the box
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9. If the list box is self-explanatory and does not require a label, select its label and press
Delete to remove it.
See the Fig. 4.8

4.11 CREATING AN OPTION GROUP:

An option group is helpful if you have a few choices for a field entry and neverenter anything
but those few choices. For instance, if you are recording the results of a multiple-choice quiz, the
answer to question 5 is always A,B,C or 0 - never anything else.

An option group can include toggle buttons, option buttons, or check boxes. Theseare simply
different styles, they all do the same thing. You can select only one choice anoner, the one you
originally selected is deselected.

To create an option group, follow these steps:

1. Make sure that the control wizards button in the toolbox is selected.
2. Click the option group button in the toolbox your mouse pointer chalges to show the

option group icon.

3. Drag your mouse pointer on your form to draw a box where you wart the option group
to appear. When you release the mouse button, the wizard starts.

4. You are asked to enter the values you want for each button. Do so,pressing Tab after
each one; then click Next.

5. Choose YES or NO when asked whether you want a default choiceJf you choose Yes,
select the default choice from the drop-down list (this choice appars automatically
when you use the form). Then click Next.

6. When asked what value you want to assign to each option, click Noctto continue. You
don't need to change the assigned default values.

7. Click store the value in this field and choose which field should reeive the data from
the drop-down list. For instance, you are entering the various coles a shetland sheep-

•



dog can be, so select the coloring field here and click Next.
8. Click to select a type of control (option button, check box or toggle button) and a style

for the controls, then click Next.
9. Enter a caption for the option group (for example, coloring). Then click Finish, you have

created your group.

4.12 ADDING COMMAND BUTTONS :
These are the buttons, in dialog boxes and elsewhere, that you click to perform actions.

Access offers a wide variety of functions you can perform with command buttons :
1. Record Navigation : You can add command buttons that move users to the next, previ

ous, first or last record.
2. Record Operations: You can make buttons that delete, duplicate, print, save or undo a

record.

4.

Form Operations: Command Buttons can print a form, open a page, close the form
and more.
Report Operations: Command buttons can print a report, send a report to a file, mail a
report or preview a report.

5.. Application: Command buttons can quit Access or run some other application.

6. Miscellaneous: Command buttons can print a table, run a macro, run a query, or use
the Auto Dialer.

3.

To place a command button on a form, follow these steps:
1. Make sure that the control wizards button in the tool box is selected.
2. Click the command Button button in the toolbox. Your mouse pointer changes to show

the command Button icon.
3. Click your form where you want the command button to appear. The command Button

wizard opens.
4. Select an action category, and then an action. Then click Next.
5. Depending on your choice of action, there may be another screen of options to choose.

Fill in the extra information if prompted and then click Next.
6. Choose Text or Picture for the buttons face. If you choose Text, enter the text you want;

if you choose picture, select a picture from the list. Then click Next.
7. Type a name for the button.
8. Click Finish. The button appears on your form. You can move it around as with any

other control.

4.13 INSERTING ACTIVE X CONTROLS :
Active X controls are new kinds of OLE controls used to share information among office

programs, or add extra functionality to your forms. Most, beginning users have no occasion to use
them, but you might occassionally need to employ one. If you have office 2000 Developer, it in-

\
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cludes a set of extra Active X controls that you can use with all office programs.

To place an Active X control on a form, follow these steps:

1. From the Insert menu choose Active X control. The Insert Active X control dialog box
opens.

2. Choose the type of control you want.

3. Click OK. The control appears on the form.

4. Drag it to the spot where you want it.

Then right-click it and choose properties to set up its properties.

4.14 SUMMARY :

A better data-entry method is to create a form with a form, you can allot as much space as
needed for each field, and you can enter information into several tables at once. There are three
ways to create a form :

1. With Auto Form,

2. with Form Wizard,

3. From Scratch.

You can make the form more attractive by moving controls, Resizing controls, viewing Head
ers and Footers, Adding labels, Formatting controls, changing Tab order etc

4.15 MODEL QUESTIONS :
1. What is a Form? Explain the purpose of Forms in a Data base.
2. What are the different methods of creating a Form ?

3. How can you add controls to a Form ?

4. How can a Form be modified?

4.16 REFERENCE BOOKS :
1. Ron Mansfied

2. Guy Hart Davis

- Working with Ms Office - Tata Mc Graw Hill 2000.

- 'The ABC's of Microsoft office - B.P.B Publications, New
Delhi.

3. Ms Office 2000 Complete - BPB Publications, New Delhi.

4. Faithe Wempen - Access 97 - PHI Private Limited, New
Delhi.

Dr. Ch. Suravinda
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LESSON -5

ENTERING DATA
5.0 OBJECTIVE :

After going through this lesson the student can know how to add records to a table and in a
form.

STRUCTURE:
5.1 Introduction
5.2 Entering a Record
5.3 Some Data-entry tricks
5.4 Moving Around in a Table
5.5 Printing a Table
5.6 Closing a Table
5.7 Entering Data in a Form
5.8 Summary
5.9 Model Questions
5.10 Reference Books

5.1 INTRODUCTION :
In the previous lessons you learned how to create a table structure, a Forms and fine-tuned

them with the settings you want. It is finally time to enter records. A record is a row in your table. It
contains information about a specific person, place, event or whatever. You enter a value for each
record into each field (column) in your table.

5.2 ENTERING A RECORD :
For entering data into a Record first, you must open the table. To open a table, double click it

in the Database window or click it once and then click open. Then follow these steps to enter a
record.

1. Click the first empty cell in the first empty column.
2. Type the value for that field.
3. Press Tab to move to the next field and type its value.
4. Continue pressing Tab until you get to the last field. When you press Tab in the last field,

the insertion point moves to the first field in the next line, where you can start a new
record.

5. Continue entering records until you have entered them all.

5.3 SOME DATA-ENTRY TRICKS :
You can enter all your data with nothing more than the Tab key and some typing, but here are

a few keyboard tricks that make the job easier.

I
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In the earlier steps, you pressed Tab to move from field to field in the table, but you might find
other ways to move around that are even more convenient. For instance, you can click in any field
at any time to move the insertion point there. The following are the keyboard shortcuts for moving
around in a table.

To insert the current date, press Ctrl + ; (semicolon). To insert the current time, Press
Ctrl + : (colon).
To repeat the value from the same field in the previous record press Ctrl + " (apostro
phe).

5.4 MOVING AROUND IN A TABLE :

TO MOVE TO PRESS
Next field
Previous field
Last field in the record
First field in the record
Same field in the next record
Same field in the previous record
Same field in the last record
Same field in the first record
Last field in the last record
First field in the first record

Tab
Shift + Tab
End
Home._
t
Ctrl+.
Ctrl+.
Ctrl + End
Ctrl + Home.

5.5 PRINTING A TABLE :
Normally, you won't want to print a table-it won't look very pretty. A table is just a plain grid of

rows and columns. Instead you will want to create and print a report that contains exactly the data
you want. Sometimes, however, you might want a quick printout of the raw data in the table, in that
case, follow these steps:

1. Open the table (by double clicking it or choosing it and clicking open).
2. Click the print button on the toolbar. The table prints.
You can set some printing options before you print if you want. Rather than click the print

toolbar button, choose print from the file menu and select your printing options from the print dialog
box. Then click OK to print.

5.6 CLOSING A TABLE :
A Table is just a window. To close it you simply click its close button (X), press Ctrl + F4 or

double click its control menu icon.

5.7 ENTERING DATA IN A FORM :
The point of creating a form is so that you can enter data more easily into your tables. The

form acts as an attractive "mask" that shields you from the plainness of your table. When you
create a form, follow these steps to enter data into it.

I
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1. OPEN THE FORM:

_ If your form appears in Form Design view, choose, view, Form view to enter Form
view or select Form view form the view button.

_ If the form is not open at all, click the Form tab in the Database window and then
double-click the form's name or click the open button.

2. Click the field you want to begin with and type your data.
3. Press Tab to move to the next field. If you need to go back, you can press shift +Tab to

move to the previous field. When you reach the last field, pressing Tab moves you to
the first field in a new, blank record. To move to the next record before you reach the
bottom field or to move back to previous records, click the right and left arrow buttons
on the left end of the navigation bar at the bottom of the window.

4. Repeat steps 2 and 3 to enter all the records you like. They are saved automatically as
you enter them.

5.8 SUMMARY :
In this lesson, you learned to enter records into a table, to print the table and to close it. The

easiest way of entering data into your table is creating a simple form and add data to it.

5.9 MODEL QUESTIONS :
1. Explain the method of entering a Record to a table.

2. List out some Data entry tricks.

3. How can you move Around in a Table?

4. Explain the method of printing a Table. .

5. How can you close a Table.
6. Explain the method of entering Data in a Form.

5.10 REFERENCE BOOKS:

1. Ron Mansfied

2. Guy Hart Davis

- Working with Ms Office - Tata Mc Graw Hill 2000.

_ 'The ABC's of Microsoft office - B.P.B Publications, New
Delhi.

3. Ms Office 2000 Complete - BPB Publications, New Delhi.

4. Faithe Wempen - Access 97 - PHI Private Limited, New
Delhi.

Dr. Ch. Suravinda



LESSON-6

EDITING DATA
6.0 OBJECTIVE:

After, going through this lesson the student can know how to edit data in a table.

STRUCTURE:
6.1 Introduction
6.2 Replacing a cell's content
6.3 Editing a cell's content
6.4 Moving Around within a cell
6.5 Selecting Records
6.6 Inserting New Records
6.7 Deleting Records
6.8 Moving and Copying Data
6.9 Summary
6.10 Model Questions
6.11 Reference Books.

6.1 INTRODUCTION :
Very few things are done perfectly the first time around. As you enter records into your tables,

you might find you need to make some changes. Editing a cell's content is easy. You can replace
the old content completely or edit it.

6.2 REPLACING A CELL'S CONTENT :
If the old content is completely wrong, it is best to enter new data from scratch. To replace the

old content in a field, follow these steps :
1. Select the cell by moving to it with the keyboard or by clicking it. To select the cell by

clicking it, position the mouse pointer at the left edge of the field so the mouse pointer
becomes a plus sign, then click once.

2. Type the new data. The new data replaces the old data.

6.3 EDITING A CELL'S CONTENT :
If you have a small change to make to a cell's content, there is no reason to completely retype

it; just edit the content. Follow these steps :
1. Position the mouse pointer in the cell, so the mouse pointer looks like an I - beam.
2. Click once. An insertion point appears in the cell.
3. Move to the location in the cell where you want to start editing.
4. Press Backspace to remove the character to the left of the insertion point or Delete to
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remove the character to the right of it. Then type your change.

6.4 MOVING AROUND WITHIN A CELL:

TO MOVE PRESS
One character to the right
One character to the left
One word to the right
One word to the left
To the end of the line
To the end of the cell
To the begining of the line
To the begining of the cell

~

~

Gtrl + ~
Gtrl + ~
End
Gtrl + End
Home
Gtrl + Home

6.5 SELECTING RECORDS
In addition to editing individual cells in a record, you might want to work with an entire record.

To do this, click the gray square to the left of the record ( the record selector). The entire record
appears highlighted.

You can select several records as a group (select the first one and hold down shift while you
select the others). You can select only continuous groups of records. You cannot pick them from all
over the list.

You can select all records at once in several ways. Glick the blank box at the inter-section of
the row and column headings; press Gtrl + A ; or choose select All Records from the Edit menu.

When you select a record, a triangle appears in the record selection area. Along with it you
might see two other symbols in this area i.e.(1) Being entered or edited (2) * Empty line for next new
record.

6.6 INSERTING NEW RECORDS :
New records are inserted automatically. When you start to type a record, a new line appears

below it, waiting for another record. You cannot insert new records between existing ones: you
must always insert new records at the end of the table. If you want the Records in a different order,
you can do it through sorting.

6.7 DELETING RECORDS:
If you find that one or more records is out-of-date or does not belong in the table. You can

easily delete it. You can even delete several records at a time.

FOLLOW THESE STEPS:
1. Select the records you want to delete.
2. Do any of the following :

- Glick the Delete Record button on the toolbar.
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- Press the Delete key on the key board.
- Choose Delete from the Edit menu.
- Choose Delete Record from the Edit menu.
- Right click the records and choose Delete Record.

Here you have to note that Delete command removes only the selected text whereas Delete
Record removes the entire record. You can not undo a deletion, so be careful.

6.8 MOVING AND COPYING DATA :
As with any windows program, you can use the cut, copy and paste commands to copy and

move data. Follow these steps :
1. Select the fields, records, cells or text that you want to move or copy.

2. Do any of the following :
- Open the Edit menu and select cut (to move) or copy (to copy)

- Click the cut or copy button on the toolbar.
- Right click the records and choose cut or copy from the shortcut menu.

- Press Ctrl + X to cut or Ctrl + C to copy.
3. Position the insertion point where you want to insert the cut or copied material.

4. Do any of the following:
- Choose paste from the Edit menu
- Click the paste button on the toolbar.

- Press Ctrl + V to paste
- Right-click where you want it to go and choose paste from the shortcut menu.

You can move and copy entire objects, not just, individual fields and records. From the Data
base window, select the table, report, Query and so on. That you want to move or copy; then use
the cut or copy command. Move where you want the table to go and execute the paste command.

6.9 SUMMARY :
For changing information in a field, select record and insert or delete the information in the

field. In addition to editing individual field or cell in a record, you may work with an entire record. You
can't insert new records between existing ones; you must always insert new records at the end of
the table. If you want the Records in a different order it can be done with sorting.

6.10 ~ODEL QUESTIONS:
1. How can you replace a cell's content ?
2. How can you edit a Record ?
3. Explain the procedure of inserting a new record.
4. How can you Delete a Record?
5. Explain the method of moving and copying Data from a record.
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6.11 REFERECEBOOKS:
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4. Faithe Wempen - Access 97 - PHI Private Limited, New
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LESSON -7

FINDING, SORTING, INDEXING AND
FILTERING DATA

7.0 OBJ ECTIVE :
After going through this lesson the student can know the basic ways to search tor data in a

database using the features in the Find and Replace dialog box. They can learn how to tind data by
sorting and filtering and how to speed up searches with indexing.

STRUCTURE:

7.1 INTRODUCTION :

7.2 USING THE FIND FEATURE

7.3 USING THE REPLACE FEATURE

7.4 OTHER WAYS TO FIND DATA

7.5 SORTING DATA

7.6 FILTERING DATA

7.7 SAVING FILTERED DATA AS A QUERY

7.8 CREATING INDEXES

7.9 SUMMARY

7.10 MODEL QUESTIONS

7.11 REFERENCE BOOKS

7.1 INTRODUCTION:
Access has many ways of finding and organizing data and each is good tor a certain situa

tion. Find and Replace is very useful when you are working with individual instances of a particular
value.

7.2 USING THE FIND FEATURE :
The Find feature is useful for locating a particular record that you have previously entered.

For instance if you keep a database of customers, you might want to find a particular customer's
record quickly when he is ready to make a purchase, so you can verify his address. If you need to
find several records at once, Find is not the best tool because it finds only one record at a time. A
better tool for finding multiple records is a filter discussed later in this lesson.

To find a particular record, follow these steps:

1. Look at your table in Datasheet view, or examine its contents by using a form. Either
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view supports and Find feature.

2. Click in the field that contains the data you want to find, if you know which field it is.

3. Click the Find tool in the toolbar, select Edit. Find or press Ctrl + F. The Find and Re
place dialog box appears with the Find page on top.

4. Type the text or numbers that you want to find into the Find what text box.

5. The default value for 'look in' is the field you selected in step 2. If you want to search the
entire table drop, down the look in list and select the table's name.

6. From the match drop-down list select one of the following :

• Whole Field finds fields where the specified text is the only thing in that field.

• Start of Field finds fields that begin with the specified text.

• Any part of Field finds fields that contain the specified text in any way.

7. If you want to specify a search direction, search for a particular capitalization or match
formatting, click the more button to access additional controls. If not skip to step 11.

8. If you want to search forward only from the current record, open the search backward
only, select up. The default is All, which searches all records.

9. To limit the match to only entries that are the same case (upper or lower) select the
Match case check box.

10. To find only fields with the same number or date formatting as the text you type, select
search Fields as Formatted. With this option on, "01/08/55" won't find "01-08-55", even
though they are the same date, because they are formatted differently.

Don't use the search Fields as Formatted option unless you specifically need it be
cause it makes your search go more slowly.

11. Click Find Next to find the first match for your search.

12. If needed, move the Find and Replace dialog box out of the way by dragging its title bar
so that you can see the record it found. Access highlights the field entry containing the
found text.

13. To find the next occurrence, click Find Next. IfAccess can't find any more occurrences,
it tells you the search item was not found. Click Ok to clear that message.

14. When you finish finding your data, click cancel to close the Find and Replace dialog
box.

7.3 USING THE REPLACE FEATURE :
Replacing is a lot like finding, except as an extra bonus, it replaces the found text with text that

you specify. For instance, if you found that you misspelled a brand name in your inventory, you
could replace the word with the correct spelling.



Centre for Distance Education Acharya Nagarjuna University

3. To restore the records to their presorted order, select Records, Remove Filter / sort.

7.6 FILTERING DATA :
Filtering is for those times when you want to get many of the records out of the way so that

you can see the few that you are interested in. Filtering temporarily narrows down the number of
records that appear, according to criteria you select.

You can apply a filter in three ways; Filter by selection, Filter by Form, and Advanced Filter /
Sort. The first tow are the most common for casual users; so the following sections cover them.
The third method is for advanced users only.

7.6.1 FILTER BY SELECTION:
Filtering by selection is the easiest method of filtering, but before you can use it, you have to

locate an instance of the value you want the filtered records to contain. For example, if you want to
find all the students in your table that have secured 70 % marks in public examinations, you must
first locate a record meeting that criteria. You will base the rest of the filter on that record.

To filter by selection, follow these steps:

1. In a field, find one instance of the value that you want all filtered records to contain.

2. Select the Value :

• To find all records in which the field value is identical to the selected value, select the
entire field entry.

• To find all records in which the field begins with the selected value, select part of the
field entry beginning with the first character.

• To find all records in which the field contains the selected value at any point, select
part of the field entry beginning after the first character.

3. Click the Filter by selection button on the toolbar, or select Records, Filter, Filter by
selection. The records that match the criteria you selected appear.

You can cancel a filter by clicking the Toggle Filter button, or by selecting Records, Remove
Filter / sort.

7.6.2 FILTER BY FORM :
Filtering by Form is a more powerful filtering method than filtering by selection. With Filter by

Form, you can filter by more than one criterion at a time. You can also set up "or" filters, which find
records in which anyone of several criteria is matched. You can even enter logical expressions (
such as "greater than a certain value").

To Filter by form, fonow these steps :

1. In Data Sheet or Form view, click the Filter by Form button on the toolbar or select
Records, Filter, Filter by Form. A blank form appears, resembling an empty datasheet
with a single record line.

2. Click in the field you want to set a criterion for. A down arrow appears for a drop-down



To find and replace data, follow these steps:

1. Select Edit, Replace or Press Ctrl + H. The Find and Replace dialog box appears with
the Replace controls displayed.

2. Type the text you want to find in the Find what text box.

3. Type the text you want to replace it with in the Replace with text box.

4. Select any options you want, as you learned to do with the Find dialog box previously.

5. Click Find Next. Access finds the first occurance of the text.

6. If needed, drag the title bar of the Replace dialog box to move the box, so you can see
the text that was found.

7. Click the Replace button to replace the text.

8. Click Find Next to find other occurrences if desired, and replace them by clicking the
Replace button.

If you are certain you want to replace every instance of the text in the entire table, click
Replace All. It is quicker than alternating repeatedly between Find Next and Replace.
Be careful, though you might not realize all the instances that might be changed. For
instance, you wouldn't want to change ''will'' to ''would'' only to find that ''willfully'' has
been changed to "wouldfully". Unlikeword's Find and Replace feature, there is no ''whole
word" option in the Access Find and Replace dialog box.

9. When you finish replacing, click cancel.

7.4 OTHER WAYS TO FIND DATA:
The Find and Replace feature works well on individual records, but there are several more

ways of locating data in your database. They include, sorting, Filtering, Indexing, Querying and
Reporting.

7.S SORTING DATA:
Even though you enter your records into the database in some sort of logical order, at some

point you will want them in a different order. For instance, If you entered the students in students
database according to register number, you might later want to look at the list according to the date
of birth.

The sort sommand is the perfect solution to this problem. With sort, you can rearrange the
records according to any field you like. You can sort in either ascending ( A to Z, 1 to 10 ) or
descending ( Z to A, 10 to 1 ) order.

Follow these steps to sort records :

1. Click any where in the field on which you want to sort.

2. Click the sort Ascending or sort Descending button on the toolbar, or if you prefer select
Records, sort and then choose Ascending or Descending.



list. Click the arrow and select the value you want from the list or, you can type the value
directly into the field if you prefer.

3. Enter as many criteria as you like in various fields.

4. If you want to set up an "or" condition click the or tab at the bottom of the window and
enter the alternative criteria (Notice that another or tab appears when you fill this one,
so you can add multiple "or" conditions.

5. After you enter your criteria, click the Apply Filter button on the toolbar. Your filtered data
appears.

You can remove a filter by clicking the Remove Filter button again or by selecting Records, Re
move Filter / sort.

7.7 SAVING FILTERED DATA AS A QUERY:
Filters are convenient alternatives to creating a simple query from scratch. You can save a

filter as a querry and use it as you would use a query: it even appears on your Queries list in the
Database window.

To save a filter as a query, follow these steps :
1. Display the filter in Filter by Form view.

2. Select File, save as Query, or click the save as Query button on the toolbar.

Access asks for the name of the new query.

3. Type a name and click Ok. Access saves the filter.

7.8 CREATING INDEXES:
Indexes speed up searches by cataloging the contents of a particular field. The primary key

field is automatically indexed. If you frequently search, sort or filter by using another field, you might
want to create an index for that field.

You can't index field whose data type is Memo, Hyperlink or OLE object.

To index a field, follow these steps:

1. Open the table in Design view.

2. Select the field that you want to index.

3. 01the general tab, click the Indexed field.

4. From the Indexed field's drop-down list appears, select either yes (Duplicates Ok) or
Yes (No Duplicates), depending on whether that field's content should be unique for
each record or not.

5. Close the Design view of the table.

6. When asked whether you want to save your changes click yes.
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You can't do anything special with an index, an index is not an object in the same way that
tables, databases and queries are. An index works behind the scenes to speed up your searches
but has no independent functions of its own.

7.9 SUMMARY :
The Find Feature is useful for locating a particular record that you have previously entered.

The Find and Replace feature works well on individual records, but there are several more ways of
locating data in your database such as sorting - Rearranging the data on screen so that it is easier
to find what you want. Filtering - Narrowing down the list to eliminate the data you know you don't
want to see. Indexing - Defining other fields besides the primary key that you want Access to keep
track of. Querying -creating a more formal filter with complex criteria that you can save and apply
again and again. Reporting-creating a printed report containing only the records and fields that you
are interested in.

7.10 MODEL QUESTIONS
1. Explain Find Feature.

2. Explain Replace Feature

3. What are the various ways of finding Data ?

4. Explain the following :

1. Sorting 2. Filtering 3. Indexing.

7.11 REFERENCE BOOKS:
1. Ron Mansfied

2. Guy Hart Davis
- Working with Ms Office - Tata Mc Graw Hill 2000.

- The ABC's of Microsoft office - B.P.B Publications, New
Delhi.

3. Ms Office 2000 Complete - BPB Publications, New Delhi.

4. Faithe Wempen - Access 97 - PHI Private Limited, New
Delhi.

Dr. Ch. Suravinda



LESSON - 8

REPORTS AND ITS PRINTING
8.0 OBJ ECTIVE :

After going through this lesson the student can know the different ways to create a reports
and printing.

STRUCTURE:
8.1 Introduction

8.2 Auto Report

8.3 Report Wizard

8.4 Report Design View

8.5 Viewing and Printing Reports

8.6 Summary

8.7 Model Questions

8.8 Reference Books

8.1 INTRODUCTION :
There are different ways to organize and view your data. Forms help with data entry on

screen and queries help you find information and display the results on screen.
You can print any table, form or query, but the results will be less than professional looking

because those tools are not designed to be printed. Reports on the other hand, are designed
specificaHy to be printed and shared with other people. With a report, you can generate profes
sional results that you can be proved of; whether you are distributing them on paper or publishing
them on the Internet.

There are several ways to create a report, such as Auto Report, Report Design view and
Report wizard.

8.2 AUTO REPORT :
If you want a plain report based on a single table or query Auto Report is suitable for you. You

can create either a tabular or a columnar report. A tabular report resembles a datasheet and a
columnar report resembles a form. They are equally easy to create.

To create a report with Auto Report follow these steps :

1. Open the database containing the table or query on which you want to report.

2. Click the Reports tab in the Database window, and click the New button. The New Report
. dialog box appears.
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REPORTS AND ITS PRINTING
8.0 OBJECTIVE:

After going through this lesson the student can know the different ways to create a reports
and printing.

STRUCTURE:

8.1 Introduction

8.2 Auto Report

8.3 Report Wizard

8.4 Report Design View

8.5 Viewing and Printing Reports

8.6 Summary

8.7 Model Questions

8.8 Reference Books

8.1 INTRODUCTION :
There are different ways to organize and view your data. Forms help with data entry on

screen and queries help you find information and display the results on screen.
You can print any table, form or query, but the results will be less than professional looking

because those tools are not designed to be printed. Reports on the other hand, are designed
specifically to be printed and shared with other people. With a report, you can generate profes
sional results that you can be proved of; whether you are distributing them on paper or publishing
them on the Internet.

There are several ways to create a report, such as Auto Report, Report Design view and
Report wizard.

8.2 AUTO REPORT :
If you want a plain report based on a single table or query Auto Report is suitable for you. You

can create either a tabular or a columnar report. A tabular report resembles a datasheet and a
columnar report resembles a form. They are equally easy to create.

To create a report with Auto Report follow these steps :

1. Open the database containing the table or query on which you want to report.

2. Click the Reports tab in the Database window, and click the New button. The New Report
. dialog box appears.

,
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3. Click on Auto Report: columnar or Auto Report tabular.

See the Fig. 8.1

4. In the drop down list at the bottom of the dialog box, select the table or query on which
you want to base the report.

Auto Reports can use only one table or query. If you want to create an Auto Report that
uses several tables, first create a query based on those tables, and then base the Auto
Report on the query.

5. Click Ok. The report appears in print preview, From here you can print the report.
The Auto Reports output is not much better than a raw printout from a table or form. For a

better looking report try Report wizard.

8.3 REPORT WIZARD:
The Report Wizard offers a good compromise between ease-for-use and flexibility. With

Report Wizard, you can use multiple tables and queries and choose a layout and format for your
report.

Follow these steps to create a report with Report wizard :

1. Open the database containing the table or query on which you want to report.

2. Click the Reports tab in the Database window and click the New button The New Report
dialog box appears.

3. Click Report wizard and click Ok. The Report Wizard starts.

4. Open the Tables / Queries drop-down list and select a table or query from which you
want to include fields.

5. Click a field in the Available fields list and then click the> button to move it to the selected
fields list. Repeat this step to select all the fields you want, or click » to move all the
fields over at once.

,
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6. If desired, select another table or query from the Tables I Queries list and repeat step 5.
When you finish selecting fields, click next. The next screen of the wizard appears.

7. If you want the records grouped by any of the fields you selected, click on the field and
click the > button. you can select several grouping levels in the order you want them.
Then click Next to move on.

By default there are no groups. You have to select a field and click the> button to create
a grouping. Grouping sets off each group on the report. If you use a field to group, the
grouping option button becomes active, and you can click on it to specify precise group-
ing settings.

8. Next you are asked what sort order you want to use. If you want sorted records, open the
top drop-down list and select a field to sort by select up to four sorts from the drop-down
lists, then click Next.

By default, the sort is in ascending order ( A - Z ). Click the AZ button next to the box to
change the sort order to descending ( Z - A ) if you like.

9. In the Next dialog box, choose a layout option from the layout area. When you click on an
option button, the sample in the box changes to show you what you selected.

10. Choose which orientation your printed report will have; portrait or land scape. Then click
Next to continue.

11. In the next wizard dialog box, you are asked to choose a report style. Several are listed,
click one to see a sample of it; then click Next when you are satisfied with your choice.

12. Finally, you are asked for a report title. Enter one in the Report text box, and click Finish
to see your report in print preview.

8.4 REPORTDESIGNVIEW :
If you want to come to Report Design view form the Database window, perform these steps :

1. Click the Reports tab.

2. Click the report you want to modify.

3. Click the DESIGN button. The report appears in Design view.
Report DESIGN view looks a lot like Form Design view. Almost everything you learned about

editing forms in the previous lessons applies to reports just like Form Design view, there is a tool
box of common editing tools. You can add all the special elements that you learned in the previous
lessons.

8.4.1 WORKINGWITH OBJECTS:
Working with report objects in Report Design View is exactly the same as working with ob

jects in Form Design View. An object is any control such as a field name or a title.

SELECTING OBJECTS:
Just like in Form Design View, you select an object on your report by clicking it. Selection
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handles (little squares in the corner) appear around it.

MOVING OBJECTS :
To move an object, first select it. Then position the mouse pointer over a border so the printer

turns into an open black hand. Then click and drag the object to a new location.

RESIZING OBJECTS :
First select the object, then position the mouse pointer over one of the selection handles and

drag the handle to resize the object.

FORMATTING TEXT OBJECTS :
Use the Font and Font size drop-down lists on the toolbar to choose fonts; then use the Bold,

Italic and Underline toolbar buttons to set special attributes.

You can also add graphic lines and objects to reports.

8.4.2 ADDING AND REMOVING FIELDS :

you can add more fields to your report at any time. Follow these steps:

1. If you don't see the field list, select view, Field list or click the Field list button on the
toolbar. A Floating box appears listing all the fields in the table you are using.

2. Drag any field form the Field list into the report place it any where in the Detail area that
you want.

To Delete a field, select it by clicking it, then press the Delete key. This deletes the refer
ence to the field form the report, but it remains in the table from which it came.

8.5 VIEWING AND PRINTING REPORTS :
When you finish a report with either Report wizard or Auto Report, the report appears in print

preview. From here you can print the report. If you are happy with it or you can go to Report Design
View to make changes.

If you want to print the report and specify any print options, such as number of copies, open
the File menu and select print. If you want a quick hard copy, click the print button on the tool bar. To
go to Report Design View, click close in print preview and you are automatically in Report Design
view. To make your report more attractive customize your report by adding and removing objects,
moving them around etc.

8.6 SUMMARY :
Reports can be created in three ways i.e. by Auto Report, by Report wizard and by Report

Design view.

8.7 MODEL QUESTIONS :

1. Explain the different ways of creating a Report.

2. Explain Auto Report
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3. How can you create a report under Report Wizard?

4. How Report Design view help to customise a report.

5. How can you print a report from print preview?

8.8 REFERENCE BOOKS :
1. Ron Mansfied

2. Guy Hart Davis

- Working with Ms Office - Tata Mc Graw Hill 2000.

- 'The ABC's of Microsoft office - B.P.B Publications, New
Delhi.

3. Ms Office 2000 Complete - BPB Publications, New Delhi.

4. Faithe Wempen - Access 97 - PHI Private Limited, New
Delhi.

Dr. Ch. Suravinda
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LESSON-9

PRINTING MAILING LABELS
9.0 OBJECTIVE:

After going through this lesson the student can know how to use a Mialing Label wizard in
Access.

STRUCTURE:
9.1 Introduction

9.2 CreatingMailingLabelswith the LabelWizard
9.3 Printing Labels
9.4 Saving Labels
9.5 Modifying Labels
9.6 Summary
9.7 ModelQuestions
9.8 ReferenceBooks

9.1 INTRODUCTION :
Access provides a Mailing Label Wizard that can speed the creation of all kinds of labels. You

can use Mailing Label Wizard for creating name tags, file folder labels, floppy disk labels, video tape
and audio tape labels. To create mailing labels, use the label wizard. Mailing labels are a type of
report, so you will start the process from the Reports tab of your database.

9.2 CREATING MAILING LABELS WITH THE LABEL WIZARD :

To create mailing labels from a table that contains names and addresses, follow these steps:

1. Open the database you want to work with and click the Reports tab.

2. Click the New button. The New Report dialog box appears. In it, click Label Wizard.

3. Open the drop-down list at the
bottom of the box and select the
table or query from which to pull
the names and addresses. Then
click Ok. The first screen of the
label wizard appears.

Seethe Figure9.1

Label wizard starts out by ask
ing you what size labels you will
be using.

J I
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4. Choose the label type from the list. If there are only a few labels listed, make sure the
show custom label sizes check box is deselected. (It must be deselected to see the
standard label types).

If you donnot know the Avery number for your label, move through the labels listed until
you find one with dimensions that match those of your labels. You can also create a
custom label.

5. Click sheet feed or continous, sheetfed labels are single sheets; continious labels are
I joined to the previous and next

sheet at the top and have perfo
rated strips on the side that feed
through a dot-matrix printer.

6. Click Next> when you have en
tered your label information.

7. Next choose a font from the Font
name drop-down list, and a font
size from the Font size drop
down list.

See the figure 9.2

Choose settings for the text to be printed on the labels.

If you need to print multiple lines on each label, make sure that the font size you select
is small enough that all lines will fit. For mailing labels 8 or 10 point type works well.

8. With some fonts, you can choose a font weight. Open the Font weight drop-down list
and choose a weight. Normal will work well in most cases.

9. If you would like color labels, choose a different color from the Text color list. To do so,
click the button next to the Text color box and select from the color dialog box that
appears; click Ok to return.

10. Click the Italicor the underlinecheck
box if you want the text formatted
with those attributes. The click Next
> to continue.

11. Next, Access asks which fields to
include on the label. Select a field
from the Available Fields list and
click the> button to move it to the
prototype label.

See th~ figure 9.3

12. Continue selecting fields until all

\



fields you want to use appear on the label. Don't forget to add spaces between fields on
the same line. For instance, a space between the first and last name. You can press
Enter to start a new line on the label. Then click Next> to continue.

If there is other text you want to appear on every label, you can type it as you enter
fields. Example is a comma
to sepearate the city and
state fields.

13. If you would like your labels
sorted by a particular field,
select it on the next screen
that appears and click the
> button to move it to the
sort by list. For instance,
some bulk mailings require
you to sort by ZIP code or
postal code. click Next> to
continue.

See the figure 9.4

If you pick more than one field to sort by Access sorts the records first by the first field
you select, then by the sec-
ond and so on. So it is im
portant to choose the field
that you want to sort by first.
If they are in the wrong or
der, click the « button to re
move them all from the sort
by list, then start over.

14. In the last screen, you are
asked for a title. Enter one
and click Finish, your labels
appear in print preview, just
like any other report.

See the figure 9.5

9.3 PRINTING LABELS :
Mailing labels created by the label wizard in print preview.

Since the labels, like a chart are considered a report, the procedure for working with them in
print preview is exactly the same as the procedure you learned already. You can print by clicking the
print button, or close the pritn preview box by clicking the close button.

J J
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9.4 SAVING lABELS:
To save your labels, just exit from print preview. You will see the labels appear in the Data

base window on the Reports tab. Unlike with a chart or report, Report Design view does not appear
automatically when you close print preview.

9.5 MODIFYINGlABELS :
If you want to modify the labels, you can enter Report Design View and make changes, just

as you would with any report. Just click on the labels on the Reports tab, then click design. Your
label design appears, you can modify your label, just as you would modify any report.

Use all the same editing techniques that you learned previously, "customizing a Report", to
make changes to your label.

9.6 SUMMARY :
Access allow us to create mailing labels directly from an address book database. To create

mailing labels, use the label wizard.

9.7 MaDEL QUESTIONS:
1. Explain the process of creating mailing labels.

2. How can you print labels ?

3. How can you save and modify labels?

9.8 REFERENCEBOOKS:
1. Ron Mansfied

2. Guy Hart Davis

- Working with Ms Office - Tata Mc Graw Hill 2000.

- 'The ABC's of Microsoft office - B.P.B Publications, New
Delhi.

3. Ms Office 2000 Complete - BPB Publications, New Delhi.

4. Faithe Wempen - Access 97 - PHI Private Limited, New
Delhi.

Smt. P.Usha Rani



LESSON -10

RELATIONAL DATABASE
10.0 OBJECTIVE:

In this lesson we shall discuss about the different ways in which tables can be related and to
show how to create those relationships using Access.

STRUCTURE OF THE LESSON :
10.1 INTRODUCTION
10.2 RELATIONAL DATABASE
10.3 HOW RELATIONSHIP WORK
10.4 TYPES OF RELATIONSHIPS
10.5 CREATING TABLE THROUGH DESIGN VIEW
10.6 CREATION OF RELATIONSHIP
10.7 VIEWING THE RELATIONSHIPS
10.8 DELETING THE RELATIONSHIPS
10.9 CREATING A MANY TO MANY RELATIONSHIPS
10.10 SUMMARY
10.11 SELF ASSESSMENT QUESTIONS
10.12 REFERENCE BOOKS

10.1 INTRODUCTION :
There are three ways to organize databases : as flat files as a hierarchy or as relational data bases.

Flat Files:
If you keep all your information in one table in a single database file it is called a flat file simple

projects like a personal collection of names and addresses are often good flat files. Flat files are
easy to maintain. There is very little chance of misplacing or duplicating data.

10.2 RELATIONAL DATA BASE :
If the data is put in different tables or even different database files, and then to create links

between the tables or data base files. These multiple tables and database files. When used to
gether create a relational database.

Relational databases allow you to store and use large amounts of data efficiently. Frequently
used information like the names, addresses and phone numbers of your customers can be stored
in one table, while other information - data concerning orders is stored in another table. This way,
there's no need to keep the name, address, and phone number of each customer as part of the
record for each order instead a link between the two tables allows that data to be stored in one table
and accessed for use in the other. A third table for invoices could then be linked so it could pull data
from each of the first two tables. This is not only minimises the amount of storage needed for large,
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complex data bases but can also minimize retyping of frequently used information.

Example : Video store database :

PICTURE: 10.1
One table is called customers. It contains each customer's name, address, phone number,

customer 10 number and so on.
Another table is called Tape Inventory. It is a list of tapes, containing each tape's (movie) title,

a unique number to identify each copy of that title, a brief description (Subject), and so on.
The Table Reservations collects reservation dates, tape numbers, the 10 of the employee

making the reservation, and so on.
Finally there is the Employee table containing employee 10 numbers, names, and other usual

data contained in employee records.
As you probably know from your trips to the video store employees routinely call customers

from lists (Printed or on screen) to confirm reservations to ask for overdue tapes and so on. Linking
these four tables in the video store data base means that the parts become more than the whole.

10.3 HOW RELATIONSHIP WORK :
When you design a query or report, you start by opening the various tables you want to use.

For example you will need the tables Tape Inventory and customers.

PICTURE :10.2
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The numbers in the customer ID field and in the who has? fields match. That is they are
related. Since the two fields in the example have already been related Microsoft Access has drawn
a line between them.

10.4 TYPES OF RELATIONSHIPS
There are three types of Relationships.

• One to Many
• Many to Many
• One to One

A relationship works by matching the data in two different tables using a common primary field.

ONE - TO - MANY:

This is the most widely used relationship. One table can have many matching records in
another table.

MANY-TO-MANY:

A record in one table can have many matching records in another and vice versa. To achieve
this in Access, you, need to create a "Junction Table" and then relate the two tables to this junction
tables.

ONE - TO - ONE:

A record in one table matches one record in another. Both are linked by their primary keys.

10.5 CREATING TABLE THROUGH DESIGN VIEW :
First create your database structure - identifying which all fields are required. Once you have

decided this structure you can then create a table in the design mode.
1. Choose New Command From File menu.

The following dialog box would be displayed.
2. Select the Database icon by clicking on it.
3. Click OK button to continue.

The following dialog box would be displayed.
4. Give the name of the folder in which you want to save your database.
5. Give the name of the database.
6. Click on create button to create your new database.
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PICTURE: 10.3

Yqur new database has been created. Double click on the create table in Design View Op-
tion.
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PICUTRE :10.4

A table in the following 'format would be displayed. Here you can see three columns. Define the
various fields in the Fields column. What type column would it be Le. alphabetical, numeri
cal, autonumber etc. Can be given in the Data Type column. The Description field is op
tional. It helps you describe the field.

2. When you click in the Data type column, a drop down list automatically appears. You can
choose the type from the list given here. The employee code here has been taken as auto
number. First name as text type and so on.
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3. Click save icon from standard tool bar to save the format of the table.

PICTUFE : 10.5

The following dialog box would be displayed.
4. Glick here and give the name of the Table.

5, Click on OK button to save the table.
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PICTURE: 10.6.1

The following message box would be displayed. It is said here that the table has no primary key
defined.

6. Click on yes button to let Access define the primary key.
7. Click on close button to close the table.

PICTURE: 10.6.2

Now the same way make another table called salary and define fields as Employee code,
Basic, DA, HRA, CCA, PF, Income Tax, Net Salary, Month of Salary and year of Salary.
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PICTURE: 10.7
Save it and close it.

10.6 CREATION OF RELATIONSHIP :
Now link the two tables i.e. Employee table with salary table.

1. Choose Relationships command from Tools menu.
PICTUIRE : 10.8



Data Base Applications Relational Database

2. Click the Employee code field in the employee table. Keep your mouse pressed and drag
your mouse pointer on top of the option 10 in salary table. Now leave your mouse. The
following dialog box would be displayed.

3. Click on Create button to create the relationship between the two tables.
4. As you can see here that the tables are now linked together.
5. Click the close button to close the dialog box.

PICTURES: 10.9
It will now ask whether you want to save the relationship that you have just created.
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PICUTRES : 10.10

6. Click on yes button to save the changes made.

10.7 VI~WING THE RELATIONSHIPS:
Thei types of relationships between tables are graphically indicated by special symbols in

Relations!llip tables.
You can view the relationships by following these steps.

1. Open the Database.
2. Click the Relationship tool bar button.
3. When you see the Relationship window, click on show All Relationships button to see All

Relationships in database.
4. Click the show Direct Relationships to see only the relationships for the table currently

highlighted in the Data base window.
5. Click once on a relationship line to select the line.
6. Double click on a selected line to display the Relationships dialog box, which is where you

can view and modify Relationship settings.
7. When you have finished, close the Relationship dialog box. Close the larger Relationships

diagram window on the same way.



10.8 DELETING RELATIONSHIPS
From time to time you will need to delete relationships. For instance, Access might create

unwanted relationships. When you, setup a new database, or you might try to change field type,
only to find that relationships exists and that they will have to be deleted before you can make the
type changes.

TO DELETE A RELATIONSHIP:
1. Display the Relationship window showing the relationship to be deleted.
2. Click once, carefully on the relationship line to select it.
3. Press DEL to remove the relationship. You will be asked to confirm the deletion. The line

should disappear.

10.9 CREATING A MANY TO MANY RELATIONSHIP:
In a many-to-many relationship, a record in one table can have many matching records in

another table. In such a relationship neither table is the parent. To create this type of relationship we
need to have an intermediary table, known as junction table. The junction table contains new fields
which have the same characteristics as the primary key fields from each of the other two tables.
With in the junction table these fields are set to be primary keys, but will act as foreign keys to the
two tables we want to relate.

10.10 SUMMARY :
Microsoft Access 2000 database management system is the product to use. Access is a

relational database management system through which you can have multiple tables, all linked to
each other through a common field, each table containing a specific type of information.

It is wise to put data in different tables or even different database files, and then to create link
between the tables or database files. These multiple tables and database files, when used together
create a relational database.

10.11 SELF ASSESSMENT QUESTIONS :
1. Explain the creation of Relationships.
2. What are the different types of Relationships.

10.12 REFERENCE BOOKS
1. Working in Microsoft Office
2. MS Office 2000
3. Microsoft Access 2000

Ron Mansfield
Sanjay Saxena
Paul Cassell,
Pamela Palmer.

Smt. P.Usha Rani



LESSON - 11

EXPRESSIONS AND OTHER AUTOMATION
11.0 OBJ ECTIVE :

In this lesson we shall discuss about the Expressions and other Automation.

STRUCTURE OF THE LESSON
11.1 INTRODUCTION
11.2 EXPRESSIONS
11.3 PARTS OF AN EXPRESSION
11.3.1 CONTROL NAMES
11.3.2 OPERATORS
11.3.3 IDENTIFIERS;FIELDAND TABLE NAMES
11.3.4 FUNCTIONS
11.3.5 LITERALS
11.3.6 CRITERIA
11.4 USING EXPRESSIONS IN REPORTS
11.5 USING EXPRESSIONS IN QUERIES
11.6 USING EXPRESSIONS IN FORMS.
11.7 EXPRESSION BUILDERS
11.8 OPTION GROUPS, CHECK BOXES AND OPTION AND TOGGLE

BUTTONS
11.8.1 OPTION GROUPS
11.9 LIST AND COMBO BOXES
11.10 CREATING LIST I COMBO BOXES

11.11 COMMAND BUTTONS
11.12 SUMMARY
11.13 SELF ASSESSMENT QUESTIONS
11.14 REFERENCE BOOKS.

11.1 INTRODUCTION :
Database management often requires a number of specific steps and must be carried out in

a definete order. Access provides tools that can be used to automate these complex tasks, making
experienced users more productive and enabling novices to accomplish things with minimum of
technical expertise. Using expressions allows you to minimize data storage as well as to prevent
data integrity problems. These expressions can be used in reports, forms, queries, and even while



Centre for Distance Education 11.2 Acharya Nagarjuna University

creating new fields in tables.

11.2 EXPRESSIONS:
Expression can assist in achieving the goals and will give flexibility and display data. Expressins
can.

o Change the property settings based on calculations or validation rules.
o Enter and use calculations in queries and filters
o Set the stage for different actions in Macros
o Add arguments to Access Basic procedures
o Change Properties in SOL queries.

11.3 PARTS OF AN EXPRESSON :
Access Expression always begin with an equal sign (=) and are entered in to text boxes or

directly into property sheets. Expressions contain some or all of the following parts :
• Control names (names of text boxes, buttons, and so on)
• Operators (+,-,*, AND, OR, <,>, and so on )
• Identifiers (field and table names)
• function names (DATE, SUM, and so on)
• Literals (numbers, dates, or texst settings)
• Constants (Unchanging values)
• Criteria (> 10, and so on)

11.3.1 CONTROL NAMES:
A control name is a name that will contain the results of formula. For example, if you create an

expression to compute a 10 percent discount on list prices, the control name might be Discounted
price, and the expression could be = [ LIST PRICE] * 9. When Access uses this expression, it will
place the results of the computation in the Discounted price control.

11.3.2 OPERATORS:
Operators do the necessary calculations and comparisions. The Access operators which include.

Arithmetic
Comparison
Concatenation
Logical
Pattern matching
Miscellaneous.

The following are the listings of all the operators by group :

ARITHMETIC OPERATORS:
Arithmetic operators perform computations like addition and subtraction.
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OPERATOR OPERATION
A Exponentiation
* Multiplication

+ Addition
Subtraction

I Division
Mod Modulo Arithmetic
\ Integer division

COMPARISON OPERATORS:
Comparison operators determine relative values.

OPERATOR MEANING
< Less than

<= Less than or equal to

<> Not equal to

= Equal to

> Greater than

>= Greater than or equal to

CONCATENATION OPERATOR:
Concatenation operator is used to manipulate the text strings.

OPERATOR OPERATION
& Used for text strings concatenation

(Forex : First name "&" Last name)

Logical operators : Logical operators build logic statements
OPERATOR OPERATION

And Conjunction
Eqv Equivalence
Imp Implication
Not Negation
Or Disjunction (inclusive or)
X or Exclusion (Exclusive or)

Pattern matching Operator: The Pattern matching operator is used for text searching.

Operator Operation
Like String comparison

Miscellaneous Operators : The remaining operators perform a variety of functions.
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OPERATOR DESCRIPTION
Separates parts in an identifier; tells Access that the object name that
follows it refers to a user-defined object.

• (dot) Separates parts in an identifier, precedes the name of the object,
method or property.

8etween ....And Determines whether the value of an expression lies within a specified
range of values.

In Determines whether the value of an expression is equal to any of
several values in a specified list.
Used with the reserved word "Null"; determines whether an expres
sion is NULL.

Is

11.3.3 IDENTIFIERS; FIELD AND TABLE NAMES:
Identifier help Access in direction of the desired data. Identifiers might be the name of an

object or collection of objects, a form name, a table name, a property name, and so on. You must
enclose an objects name in brackets when typing it in an expression; (Unit Price) is an example.

11.3.4 FUNCTIONS:
Functions are built-in tools that can be used for specific, often complex tasks. Functions fall

in to four categories.

• Conversion

• Date / Time

• Math
• Text.

Conversion functions convert the numbers to integers or days of the week to their
numeric equivalent.

Date and Time functions either perform date and time computations or they return
current system dates and times.
Math functions perform calculations
Text functions manipulate text. For ex : to change all of the characters to upper case in
a specific field.

11.3.5 LITERALS:
Literals are values which you type in to expressions not for the purpose of computing, but

rather to be taken literally. For example in the expression.
= [price]* 1.065, the number 1.065 is a literal.

11.3.6CRITERIA:
Criteria tell Access which records are of interest criteria in queries, reports and expressions.
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11.4 USING EXPRESSIONS IN REPORTS :
Most reports contain expressions. There are three types of expression working with reports.

The first type is the simple expression that is a mathematical equation, and the second type uses
built in functions to provide a result. The third type is custom function created with visual Basic for
Applications.

When you want to create an expression in report, you must add a control to display the
results of the expression. You must add a text box to store the results. This text box will not display
field data because it's an unbound control. After the text box is added to the report you must build
the expression. When you want to use an expression, you are going to set control source property
equal to your expression rather than a specified field. This is accomplished by typing the equal sign
(=) followed by the expression.

11.5 USING EXPRESSIONS IN QUERIES:
You can use expression to do various math calculations working across a query, Access

through built in functions can calculate not only time spans between two fields in a query, but also
dynamically calculate time differentials between a field date and the current system of date.

11.6 USING EXPRESSIONS IN FORMS:
Form can also contain expression, which are often added to the form's text boxes.

11.7 EXPRESSION BUILDERS :
The Expression Builder is similar to a wizard. This consists dialog boxes contain lists and

buttons offering available options for use in expressions.

PICTURE: 11.1
The Expression Builder construct expressions either by typing them directly, or by clicking on

the desired operators, field names and so on. To open a list, double click on the leftmost chioce of
interest. For instance, to see a list of the fields available in a table, double click first on tables
choice, then on a table.
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11.8 OPTION GROUPS, CHECK BOXES, AND OPTION AND TOGGLE
BUTTONS:

Access helps you to create a variety of buttons on forms and in reports that make it easy for
user to make choices. In additon you can add, delete and modify tool bar buttons. Instead of having
users type their choices via keyboard, you could provide them with on screen buttons. They are
toggle buttons, option buttons and check boxes. Access toggled buttons, option buttons and check
boxes should seem familiar. They all behave like their windows counter parts. When you click on a
toggle button, it depresses indicating that you have activated the choice. A check in a check box or
a dot in an option button indicates that it's activated. When selected or deselected these items all
indicate yes I no decisions to the program.

11.8.1 OPTION GROUPS:
Option groups provide user with a finite number of choices. Option group consists of a group

frame, which contains the buttons or boxes uses to make the choices and a frame label. You can
create option groups yourself or get some help from a wizard.
Creating Button Groups with the Wizard :

1. Start by opening the appropriate database
2. Choose Forms tab.
3. Click the New button.
4. Select a table or query.
5. Choose either the Form wizard or Design view option and click ok.
6. Click on the Tool box button.

_ Poll Fpoot I....~ .IM>I ·F_JleiPt ".
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Picture : 11.2
7. Click the option group button
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Picture : 11.3
8. Point to one corner of the area where you want to create the options group and drag to

outline the approximate desired size and shape of group as shown here.

Picture : 11.4
9. Type the list of options you want to display tabbing to move one row to the next, then

click the Next> button.

Picture : 11.5
10. Design the appearence of the new buttons and related elements by making the desired

choices.
11. When you move to the last wizard screen, you'll be asked to name the group. This

name will appear at the top of the group frame. Type a group name and click the Finish
button.

,
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11.9 LIST AND COMBO BOXES:
Another way to automate choices is to provide lists from which user pick. A list box or combo

box can come in handy if typing certain values repeatedly in to a field. This makes data entry much
faster and is also more accurate.

List box values are always visible and the user is limited to choosing a value from the list.
They are best used when there are only a handful of values to choose from A combo box occupies
the same amount of space as a standard text box until you click on its down arrow. Then you are
presented with a list of values to choose from.

11.10 CREATING LIST I COMBO BOXES:
1. Switch to the Desiqn view

2. Click the List box / combo box button in the tool box.

3. Drag to indicate the approximate size, shape and location of the list box.

4. The wizard asks if you want to type entries or to use values in an existing table or query
to create the drop-down list.

5. Specify the table or query that will be the source of items in the list.
6. Choose the fields that you want to see in the list.

7. The wizard will show samples of the list and asks you to size columns. Drag or double
click to specify the desired relative width.

8. Finally, you will be aksed to name the list. You can leave the proposed name or type one
of your own; then click Finish.

9. The wizard will switch to Design view and create a list of object. Either change its
location, shape and appearence or switch to Form view to test it.

11.11 COMMAND BUTTONS :
Command buttons let you make it obvious how to perform tasks necessary for your application.

1. In Desiqn mode click on the command button. Use the New mouse pointer to drag a
button shape to the desired location on form. The beginnings of a new numbered but
ton will appear, and you'll see the first wizard dialog box.

2. Choose the category of action you want the button to perform and the action from the
displayed list for the choosen category (Add new record in this example) click Next>

3. You will be asked to specify a button name or graphic to use on the buttons face.

4. You will be asked to give your button a meaningful name or accept the automatic,
incremental name.

5. Click the Finish button.

6. Switch to Form view and test the button.

11.12 SUMMARY:
Expressions can perfrom mathematical operations, provide summary information such as

totals and averages, display information about an object, format information together, Change the
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appearanceof informationina fieldandevaluatea fieldvalueto displayother informationor action.
The combobox and list boxwizardare designedto minimizeyour effort to set up these controls.

11.13 SELF ASSESSMENT QUESTIONS
1. ExplainExpressions.
2. Explainthe use of operatorsinAccess.
3. CreateButtonGroups.
4. Create List and comboboxes.

11.14 REFERENCE BOOKS:
1. Working in MicrosoftOffice
2. MicrosoftAccess 2000

RonMansfield.
Paul Cassell,
PamelaPalmer.
SanjaySaxena.3. MSOffice2000

Smt. P.Usha Rani



LESSON - 12

MACROS
12.0 OBJECTIVE:

In this lesson we shall discuss a) What macros are in Access, (b) Creating a simple macro
and (c) associating macros with events.

STRUCTURE OF THE LESSON
12.1 Introduction
12.2 Actions
12.3 Arguments
12.4 Simple Macro
12.5 Events
12.6 Creating a Macro
12.7 Summary
12.8 Self Assessment Questions
12.9 Reference Books.

12.1 INTRODUCTION :
Macros are Access objects just like Forms or Tables. Macros are the first step on the ladder

towards programming and getting Access application to do all the work. Macros like mini program
that record and automate repetitive database tasks. Macros are without a doubt, the most often use
programming aspect of Access. Simply a macro is a set of actions that can all be run together,
perhaps in response to some event. For instance, you might use a macro to open a particular form
when the user presses a certain button, or run a sequence of reports instead of having to start each
one manually. Access basic language is used to create Macros.

12.2 ACTIONS :
Access supports a wide range of Actions including opening forms and reports, moving from

record to record from with in a form; displaying messages to the user and filtering data. You can
see a list of actions by clicking the New button in the Macros pane of the Database window, and
then clicking in the Actions column.

Picture :12.1
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12.3 ARGUMENTS :
Most Macros require one or mor e arguments which tells Access how each action should be

performed. For instance to open a form, Access needs to know the name of the form. You can also
specify certain conditions which have to be met before the action occurs. Action arguments are
specified il'l the bottom half of the Macro design view.

Picture :12.2

12.4 SIMPLE MACRO
The Macro language within Access is simple way to program Access for foreseeable events

or to automate tasks. Click Macro section in the Database and open the Macro mcr Message either
by clicking!the open button or double clicking the entry.

Picture :12.3
Click OK to clear the message box. If necessary highlight the macro named mcr Message in

the Database view and click the design button to see the Macro's design. Your screen should
resemble.
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Picture :12.4
Once again you should be able to examine the macrojdeslqn grid and get a good idea of how

this macro operates. The Action column should be self-explanatory this macro's action is to display
a message box (msg box). Pay special attention to the Action Arguments section, where you'll see
entries for both the title bar and message itself.

If you want to see the macro in action so you can observe the transition from the design
elements to the running elements, click the Run button on the tool bar. This has an exclamation
point for an icon, when you're satisfied you have this maG~Q.figuredout, close it and discard changes.

<~. 'v

12.5 EVENTS :
Events are actions that occur with or to an object. For example, a mouse moving over a

button on a form is an event. Microsoft take care to name events in such away to make them easy
to associate with the real world. For example the event for the mouse cursor moving over an object
might be labelled mouse over.

Return to the. Forms section of the Database view and open the form from Macro Demo in
Form views. Move your mouse all around the form, being sure to avoid the red rectangle labelled
mouse corral. When you're satisfied that nothing's strange, pass your mouse cursor over the
Mouse corral. Your screen should resemble the following figure.
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Picture :12.5
All the controls on a form or report and even the objects themselves have a range of predefined

events that Access can respond to. For example, our button control has an on click ever which is
triggered when the button is clicked, but also has many others such as when it gets the focus,
losses the focus and so on. You can see all these events in the Event tab of the buttons property
sheet.
Attaching the Macro to the Button's on click Event.

1. In the form design view, find the button's on click event in the property sheet Events tab.

2. Select the Macro to run when the button is clicked.
3. Run the form, click the button and Access launches the macro.

12.6 CREATING A MACRO :
The following are the steps for creating a macro :

1. Open the database, click on the Macros tab (if necessary) bring It foremost, and click
on the new button.

2. You'll see an empty, two-column list into which you'll place commands and optional
notes of explanation.

3. Click in the first Action cell and choose the first desired action. In the example, the first
thing you want to do is open a query.

,



Picture :12.6

4. Action argument will appear in the bottom half of the dialog box. The actual choices
available will change with the type of action you have selected. In this case, you need to
select a query from the resulting drop down list.

Picture :12.7

That's the essence of macro building; you can add additional steps, arguments and
(optionally) notes to build a reliable macro. You can add steps to switch you from table
to table or from one view to another or to pick menu items. In fact, there are commands
you can conclude in your macros to copy, delete, navigate and do virtually anything
Access can do.
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Picture :12.8
Regularkey strokes (likeNoor Yes) are simply typed as actionargumentskey combinations

like (Alt +A ) are sent using special characters.
5. When you've finished entering steps, save the macro with the file, save command (

CTRL + S ) and test it. The following screen illustratesa completedmacro.

T,...·tIo"in ..
Tab "' .. floIIIocolllllt
T,...'V.. "in .. Rtpoce_ "'"'
T,...MWlto \oIhoIeFtOId .......
T,...Al<EIo ~Orto~FIIId .......
T,..........IO_ .. floIIIoco ... tuton

Picture :12.9

12.7 SUMMARY:
Youcreate a macrobyopeningthe macrodesigngrid, specifyinga macro actionand filling in

the Acton Arguments.Youcan optionallyspecify a macro nameto groupmacros underone name
in the Databaseview. Youcan also specify conditions for the macro to execute. The final step to
create a macro is to associatean event (usually in a report or form) with a macro.

12.8 SELF ASSESSMENT QUESTIONS
1. Explainthe creation of a macro.
2. Explainevents.

12.9 REFERENCE BOOKS :

3. MSOffice 2000

RonMansfield.
Paul Cassell,
Pamela Palmer.
SanjaySaxena.

1. Working in MicrosoftOffice
2. MicrosoftAccess 2000

Smt. P.Usha Rani
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LESSON - 13

GRAPHICS IN DATABASES
13.0 OBJECTIVE :

The object of this lesson is to explain about the OLE and creating charts.

STRUCTURE OF THE LESSON :
13.1 INTRODUCTION
13.2 OBJECTS: LINKED, EMBEDDED,BOUNDAND UNBOUND
13.3 EMBEDDEDVERSUS LINKED
13.4 UNBOUNDGRAPHICSAS FORM
13.5 BOUNDGRAPHICSIN RECORDS
13.6 CRATINGA CHART
13.7 SUMMARY
13.8 SELF ASSESSMENTQUESTIONS
13.9 REFERENCEBOOKS.

13.1 INTRODUCTION :
Microsoft Access also supports the integration of graphics for specific records. You can also

insert or link charts, drawings, photos, and other graphics into records, reports and forms. It's even
possible to link multimedia files. There are many similarities between the use of graphics in Access
and in the rest of the office suit, but there are significant differences.

13.2 OBJECTS:
Linked, Embedded, Bound and Unbound.

Object Linking Embedding (OLE) enables you to take advantage of data that was created in
another application, such as MS word or MS Excel. It can also be used to integrate graphics. with
Microsoft Access you can insert a graphic or link to a graphic file on a record by record basis.

All Access graphics are objects and are placed in object frames. You can manipulate the
frame to change the size, shape, location and cropping of graphics it contains.

When you work with OLE objects in Access

There are two types of object frames in the tools Box (1) Bound object frames and unbound
object frames. The Bound object Frame is for an object that is tied to data in a table. The unbound
object Frame is for an object that will not be linked to data in a table.
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Unbound
objects lilce
these are not
stored in tables

Bound objects
are stored in
tables

13.3 EMBEDDED VERSUS LINKED
An Access graphic (object) can be embedded, meaning that it is stored with in the Access

database, or it can be linked, meaning that the object is stored in some other file, but used by
Access. That should sound familiar.

As you embed photos, the size of your database file (the.mdf file) increases significantly,
telling you that the graphic objects are stored with in the file it self. That is embedded objects are
stored with the main data base file.

Linked objects are stored outside of the Access main database file. Because Access sup
ports OLE, you can edit both embedded and linked graphics by using the general techniques.

13.4 UNBOUND GRAPHICS AS FORM AND REPORT
EMBELLISHMENTS :

You can round up graphics from the usual sources (officer's clip ARt Gallery; art disks and so
on) and use them in Access. Graphics can be inserted either from your clipboard or with the Insert
object command then resized, moved piled .oneon top of the other, and 50 on.
Here are the general steps taken to create unbound graphics on a form or report :

1. Open the form or report of interest and switch to Design view.
2. To add an unbound object. click on the unbound object Frame button as shown here;
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Picture :13.2

3. Note that the mouse pointer changes shape. Drag to define the desired location, size
and shape of the frame.

4. When you release the mouse button, Access will insert the frame and display the Insert
object dialog box, listing a choice of object sources.

Picture :13.3

5. Pick one. (Microsoft clip ARt Gallery in this example)
6. Select or create the desired image and return to Access.

Picture :13.4
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7. Back in the Access Design window, you will see all or part of your graphic surrounded
by the frame handles.

8. If necessary, change the size mode property and drag the frame handles to get desired
effect.

9. Switch to Form view or print preview when working with reports to see how the project
is coming. Switch back to Design view alter your work to continue designing.

13.5 BOUND GRAPHICS IN RECORDS :
Some times it is useful to have graphics for each record. The promotional photos and film

clips are example in the video tape database. Suppose you want to collect and display promotional
photos in a video tape database, the steps are very similar to those used to include unbound
graphics ..

1. Start by opening a table that will contain the bound graphic or other element (the video
store tape Inventory table in this example)

2. Switch to Design view.
3. Add the necessary field or fields
4. Switch to Table view, and select the record and field where you want to insert your first

bound graphic.
5. You can use the Access Insert Object command or launch another like paint, brush,

and then copy the image to the clipboard.
6. Switch to the Access Table, if you are not already there and insert the graphic.

13.6 CREATING A CHART:
Another graphic element that can be added to report is a chart. Many people have an easier

time comparing numerical data when it is presented in a chart, with Microsoft Access you can
create a chart of your data with the help of the chart wizard. Like all the wizards, the chart wizard
will prompt you to select the information you want to chart, as well as to determine characteristics
of the chart.

The Access chart wizard lets you use Microsoft Graph to create graph objects that can be
included in Access reports. Once created, the charts can be further embellished using Microsoft
Graph itself. Here are the general steps.

1. Select the table you want to base the form on, and then choose New Form from the tool
bar.

2. Click on chart wizard and then click the ok but-
ton. I

Picture :13.5
3. You will see the chart wizard dialog box. Double

click to select the fields you want to include in
your graph.

4. Click Next> to move forward. Choose the type of
chart you want to create then choose Next >
again.
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Picture :13.6

5. Select pie chart from the list of 20 types and select Next to adjust the data layout.

Picture :13.7

6. When you click Finish, the wizard will insert a graph object In your report.
7. To modify the chart double click on it and you will see a chart.
8. Use chart options to change the appearance of the finished graph object.

13.7 SUMMARY :
Microsoft Access supports the integration of graphics for specific records. Object Linking

and Embedding (OLE) enables you to take advantage of data that was created in another applica
tion such as MS Word and MS Excel. It can also be used to integrate graphs. Access can create a
chart with the help of chart wizard.

13.8 SELF ASSESSMENT QUESTIONS
1. Explain unbound graphics.
2. Explain Bound Graphics
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3. Create a chart.
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LESSON - 14

LINKING, IMPORTING AND EXPORTING
RECORDS

14.0 OBJECTIVE:
In this lesson we shall discuss the several ways to share Access data with other programs.

STRUCTURE OF THE LESSON
14.1 Introduction
14.2 Importing Versus Linking
14.3 Importing Data from other programs
14.4 Importing Data from Excel
14.5 Importing Data from Text files.
14.6 Importing Data from word Files
14.7 Exporting Data to other programs.
14.8 Summary
14.9 Self Assessment Questions
14.10 Reference Books.

14.1 INTRODUCTION :
One of this product's great strength is its ability to interface with other applications. If you

have information stored in another format, such as in a text file or an Excel spread sheet, then
Access has the tools to import that data in to a table. Access can also export table data into formats
suitable for other applications.

14.2 IMPORTING VERSUS LINKING :
If you have data that was created with other programs like dBase, or Microsoft word, you can

convert (import) the data to Access tables, or you can link the unconverted tables so that Access
can use them with out converting. In choosing whether to import or link, there are important points
to consider.

Importing definetely has its advantages. Converted databases generally run faster than linked
ones. Some changes that can make to Access tables, can't be made to linked tables. Linking
keeps the data in its old format for use with the old tools.

14.3 IMPORTING DATA FROM OTHER PROGRAMS :
Access accepts data from a wide variety of dbase programs, making it very easy to switch to

Access without much loss of productivity. To import data from another program, follow these steps.
1. Open the Access database in to which you want to import the data.
2. Select the File> Get External Data> Import menu option. The import dialog box opens.
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Picture :14.1
3. Open the Files of Type drop down list and select the type of file the data is coming from.
4. Change the drive or folder to the one where the file is stored.
5. Double click the file name, or click it and then click Import.

14.4 IMPORTING DATA FROM EXCEL:
Before you import data from an Excel spread sheet, make sure that the spread sheet is in a

tabular format t.e. each record corresponds to a row in the spreadsheet and all the columns are
lined up properly. You will normally create a new table to store this data.

FOLLOW THESE STEPS TO FINISH THE IMPORT :
1. Select the File> Get External Data> Import menu option.
2. From the Import dialog box, select the spread sheet which contains the data you want

to import.
3. Click Next to move to page two of the Import wizard.

Picture :14.2
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4. If the first row contains your field names, click the First Row contains column Headings
check box. Click Next to continue.

5. Choose where you want to store data. In a New Table or In an Existing Table. In an
Existing Table, select the table from the drop-down list. Then click Next.

6. Choose the names for the fields you are importing. For the first field name, type a
different title in the Field Name text box, if you like, and select yes or no from the Indexed
drop down list.

7. Use the horizontal scroll bar at the bottom of the dialog box to move the next field into
view and then click it. Then repeat step 6. Go through all the fields this way, and then
click Next to continue.

8. Select a field to be the primary key click Next to continue.
9. Click Finish on the final stage of the wizard and Access imports the data.
10. Click OK at the confirmation message box to clear it. You can now see your imported

table on the Tables tab of the Database window.

14.5 IMPORTING DATA FROM TEXT FILES :
Text files are either delimited, Where records can be different lengths and special characters

are used as " markers" to show where one field ends and another begins, or fixed width which
means all 'the records are rows of data of the same length. If you are importing data from a text file,
follow the steps at the beginning of this lesson under the heading "Importing Data from other pro
grams". The Import Text wizard opens and you can follow these steps.

1. On the first screen of the Import Text wizard, Choose Delimited if your text file has
delimiters such as commas or tabs that separate each field otherwise choose Fixed
width.

2. Click Next to continue.

3. If you choose delimited, you are asked to choose delimiter character.
4. If the first row contains your field names, select the First Row contains Field Names

Check box.
5. Click Next to continue.

6. You are asked where you want information to be stored; in a new table or an existing
one. Click the In A New Table button, or click the In An Existing Table button and then
select the table from the drop down list. Click Next to continue.

7. In the Field options box, you can change the field names for each field if you like, Enter
your preferences and then click Next.

8. To allow Access to create a new primary key field, click let Access add primary key. Or
specify one of the existing fields as the primary key, if you prefer, or select No primary
key, click Next.

9. Enter a name to save the table under, and then click Finish. The table appears on your
Tables tab.

14.6 IMPORTING DATA FROM WORD FILES :
To import word files, either save the files as text and use the text-importing techniques de-
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scribed earlier, or take the following steps.
1. Place the word data in word tables organized in the same way as tables in your Access

database file.

2. Copy from the word table to your clipboard.

3. Switch to the Access table window.
4. Select the first field in the 'new' record at the end of Access table.

5. Select paste Append from the Edit menu. Access will import each word table row as a
record.

14.7 EXPORTING DATA TO OTHER PROGRAMS:
Access database can't export to another program. Access database is not a single file, it

includes various database objects such as Tables, Forms, Queries, Reports and Macros, that
don't translate easily into another program. Tables in Access contain all data. Follow these steps to
export a table.

1.· Open the database that contains the table.

2. Click the Table tab and highlight the database to export.

3. Choose File, Export, the Export Table dialog box appears.

4. Open the Save As type drop-down list and select the file type.

5. Type a name in the File Name text box to create a new file to save it in.

6. Click the save button. Access saves the table in the specified format.

14.8 SUMMARY:
With Access you can import the data from other databases, spread sheets and word pro

cessing documents, or can link non-Access files as tables with Access you can export the Access
records for use by some other program.

14.9 SELF ASSESSMENT QUESTIONS :
1. Explain Importing Data from other programs.

2. Explain Importing Data from Excel.

3. Explain Importing Data from Text files.

4. Explain exporting Data to other programs.

14.10 REFERENCE BOOKS:

Access 2000

Ron Mansfield.

Paul Cassel,

Pamela Palmer.

Faithe Wempen.

Working in Microsoft Office

Microsoft Access 2000

Smt. P.Usha Rani
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